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Introduction
The Océ Scan software is a program that enables you to scan-to-file and to 
process images. It works in conjunction with:

n The Océ CS4xxx scanners

Features
n Colour feature extraction to maintain high-quality scans, with minimal file 

size and storage requirements.
n Ability to zoom in and view scanned images.
n A complete set of colour and image processing tools.
n Conversion between file formats.
n Color management support with ICC profiles for TIFF and JPEG file 

formats. 
n Alignment, horizontal deskewing, image rotation, electronic despeckling, 

and image mirroring.
n Angle and distance measurements between selected points
n Adjustable scaling and automatic scaling
n Autosize with new options: Snap to known size; Image size or; Paper size 

detection.
n Print to inkjet and laser printers
n Scan to pdf
n Scan to Net
n Now works as a TWAIN driver, giving a familiar interface directly to 

applications supporting TWAIN acquisition. 
n Support of a wide range of standard industry image file formats, including 

TIFF, JPEG, JPEG 2000, CALS, CCITT Group 4 compressed formats, 
Intergraph RLE and CIT, and Image Systems CADOverlay RLC format for 
AutoCAD.

Scanning modes
n Black and white
n Graytone
n Colour: true colour, indexed colour, and feature extracted colour
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Operating modes
The Océ Scan software scans documents in the following colour and black and 
white modes:

24 bit RGB colour mode   This mode scans images at the full 24-bit true colour 
mode for 16.8 million colours. 

Indexed colour mode   When you scan documents with a limited range of 
colours, this mode maps true colours to an indexed colour palette. The scanner 
generates this colour palette automatically when it does an adaptive colour 
prescan of the original.

The scanner’s ability to transform a true colour image from 16.8 million 
colours down to 16 or 256 colours greatly reduces the data volume. At the 
same time, the scan speed increases and the disk storage requirements decrease 
(needing only 4 bits or 8 bits per pixel, compared with the 24 bits required in 
true colour mode).

Feature extracted (classified) colour mode   This mode uses colour mapping 
to sort the observed colour features in a document and to classify them into 
categories using a colour LUT (look up table). You can generate this LUT once 
and download it to the scanner for a similar class of documents. Colour 
mapping can improve details in complex maps or drawings, while increasing 
the scan speed and minimizing disk storage requirements.

Graytone mode  (256 levels) This mode scans the actual gray level of each 
pixel, up to 256 levels. Each pixel corresponds to 1 byte (8 bits). The images 
scanned in graytone mode result in files that are 8 times larger than 
uncompressed files scanned in lineart mode at the same resolution. 

Lineart mode   (2-level) This mode reproduces each scanned pixel as a single 
bit, either black (1) or white (0), depending on whether its gray level lies below 
or above the threshold level. This mode supports both fixed level and 2-D 
adaptive thresholding.

Dithered mode   (halftone dither) Converts gray levels of the scanned pixels 
into halftones by dithering. This results in very high density line mode files 
that are much larger than uncompressed files scanned in line mode at the same 
resolution.
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Install the software
Océ Scan runs on Windows 2000, XP and Server 2003. It requires a properly 
installed and powered on scanner in order to execute all of its functions.

System requirements
n IBM PC or compatible, 200 MHz or higher
n Windows 2000, XP and Server 2003
n 24 bit (true colour) graphic display
Note: To speed up scanning, it is recommended that you maximize your 
workstation memory as Océ Scan uses the available memory for buffers during 
the scanning process.

Software installation
See the “Readme.htm” on the Océ Scan CD for up to date information about 
installation on newly supported computers and operating systems.

t To install Océ Scan
1 Start Windows 2000, XP or Server 2003.
2 Insert the Océ Scan CD in the CD-rom drive.
3 From the Windows “Start” menu, choose “Run”.
4 Type “D:\setup” in the command line. 

Note: Replace “D” with the letter of you CD-rom drive.
5 Click OK.
6 Follow the instructions from the installation wizard.

Note: During installation, you are prompted to enter your serial number. 
This number is located on a sticker on the Océ Scan CD jewelbox.

Software upgrade
See the “Readme.htm” on the Océ Scan CD for up to date information about 
software version upgrading procedures.
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Start Océ Scan
Before you work with Océ Scan, check that you have :

n installed Océ Scanner Agent and Scanner Maintenance software (Please 
refer to the Scanner Maintenance user manual for more details)

n performed the scanner maintenance (as described in your scanner installation 
manual)

n switched on your scanner before you switch on the computer. This allows the 
computer to detect the scanner connection.

t To start Océ Scan
1 From the Windows ‘Start’ menu, select ‘Programs’/’Océ Scan’.
2 Choose Océ Scan.

Use Océ Scan in ‘Demo mode’
When you start the software without a connection to a scanner (or before you 
turn on the scanner), Océ Scan runs in ‘demo mode’ which allows you to:

n Rescan the SCSI bus, if you turned on the scanner after the computer
n Use the “View” and “Feature” functions with previously scanned images

In ‘demo mode’, you cannot:

n Scan
n Save to file from the ‘View’ window’s ‘File’ menu
n Print
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Océ Scan main window
When you start Océ Scan, the following window appears:

[1] Océ Scan main window
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Océ Scan windows
In Océ Scan, the default main window is the “Scan” window. To navigate 
between windows, click on the window’s corresponding tab at the bottom left 
of the screen.

[2] Océ Scan window tabs

Scan window (main window)  lets you perform all scanning operations, 
including the selection of scanning parameters and preferences. 

View window   allows you to display different image types while using various 
image manipulation functions such as zooming, cropping, and colour 
adjustments. 

Feature (LUT) window  enables you to reduce and classify the colours of a true 
colour input image, and to create a filter which you can download to the 
scanner for subsequent use on a similar class of images. 

Access user documentation
You can find complete details about the user functions in Océ Scan through the 
‘Online User Guide’.

t To access the online User Guide
1 From the ‘Help’ menu, click ‘Contents’.
2 From the right window, check ‘About Océ Scan’ to access a brief introduction 

to Océ Scan.
3 For details about the scanning, viewing, or feature extracting functions, click 

the corresponding topic in the table of contents on the left window.
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Calibrate your scanner

Prerequisites
To calibrate the scanner, you require the following items (provided with the 
Scanner Maintenance Kit):

n The Scanner Maintenance software installed
n The Scanner Maintenance sheet (to perform camera alignment, stitching and 

basic calibration)

Why calibrate
Colour calibration ensures a stable linearity, colour balance, and chromacity of 
your scans.

You need to repeat this operation about once every two months of continuous 
scanning, or when the quality of scanned colours becomes unsatisfactory.

Note: Calibration must be performed after the cleaning of the scan area to 
ensure precise calibration results.

How to calibrate

t To calibrate the scanner
1 Make sure the scanner has been turned on for at least one hour prior to 

calibrate.
2 From the ‘Scan menu’, select ‘Calibrate Scanner’. 

The Scanner Maintenance software is launched.
3 The wizard will guide you through the calibration process. 

Note: Fore more information, please refer to your scanner installation 
manual, to the Scanner Maintenance instructions leaflet delivered with the 
Scanner Maintenance software and to the Scanner maintenance user 
manual.
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Selecting preferences
You can customise certain features in Océ Scan, to adapt to your preferred 
working method, such as:

n  Measurement unit (inch or millimetre)
n  Colour space (RGB or HSV) to use in the ‘View’ and ‘Feature’ windows
n  Scanning preferences
n  Prescanning preferences
n  Batch scanning preferences

t To choose the measurement unit
1 From the ‘File’ menu, select ‘Preferences’.
2 Select ‘Unit’. A dialog box appears.
3 Choose millimetres or inches.

t To choose the colour space
1 From the ‘File’ menu, select ‘Preferences’.
2 Select ‘Colour info field’. A dialog box appears.
3 Choose ‘RGB’ or ‘HSV’.

Scanning preferences

t To choose scanning preferences
1 From the ‘File’ menu, select ‘Preferences’.
2 Select ‘Scanning’. A dialog box appears.
3 From the ‘General’ tab, select your preferences as follows:

n ‘Display during scanning’

Note: Deselect one of the options if you want to speed up the scanning process.

‘Detailed view’ displays the details of the image during the scan
‘Overview’ displays the entire image during the scan
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‘Default scan file’ (when you save to file) option  

‘Paper position’ option  

Scanner speed  Use the slider to adjust the speed of your scanner. Sometimes, 
the performance of your workstation causes the scanner to make repeated 
back-ups during scanning in order to ensure correct and continuous processing 
of scanned data. Reduce the scanner speed to avoid these back-ups.

Colorspace  When you calibrate the scanner, profiles for both NTSC and 
sRGB are created. Selection of a color space in this section determines the 
color profile you want to use while scanning and working with Océ Scan.

Note: The NSTC colour space has a slightly larger color gamut than sRGB.

n NSTC: Color matching between different devices (scanner, printer, monitor) 
requires color matching via the processing of ICC profiles.

n sRGB: It is not necessary to perform Color matching as long as the used 
devices are also set to sRGB standard.

Prescanning preferences

t To choose prescanning preferences
1 From the ‘File’ menu, select ‘Preferences’.
2 Select ‘Scanning’. A dialog box appears.
3 From the ‘Prescan’ tab, select your preferences as follows:

‘Prescan mode’ option   

‘Index Prescan resolution’   (for colour scanners) selects the resolution to use 
during prescans in the indexed mode.

‘Histogram prescan resolution’   selects the resolution to use during histogram 
prescans.

‘None’ lets you enter a new name for each scanned document
‘Last scan file’ lets you reuse the same name as the previously scanned 

document. This can be useful, when you make multi-
ple test scans of the same image.

‘Side’ You load the document right-aligned
‘Centered’ You load the document centre-aligned

‘Single pass’ The prescan stops at the end of the document
‘Continuous’ The prescan continues back and forth, until you press ‘Halt’
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‘Alignment detection scan length’   specifies how far to scan, in order to find a 
line usable for automatic alignments.

‘Paper size detection scan length’   specifies how far to scan, in order to find 
indications of the original’s edges and paper size.
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Batch scanning preferences
You can log information pertaining to each batch scanned and each file 
scanned in a batch.

t To choose batch scanning preferences
1 From the ‘File’ menu, select ‘Preferences’.
2 Select ‘Scanning’. A dialog box appears.
3 From the ‘Batch scan’ tab, select your preferences as follows:

‘Log for each batch’ option  Image format, scan mode, resolution, scan 
adjustments, .

‘Log for each scan’ option  File name, file size, paper size, hollerith code.

‘Log format’ option  
‘Verbose’ This option presents the log data in a readable format 

used for normal reference purposes
‘Compact, comma- 
separated’

This option presents the log data in a format export-
able to another application, such as a spreadsheet or 
database. Column headers appear only in a new or 
empty log file; otherwise the data appears without 
headers. The information fields that are irrelevant to 
the scan remain empty. Each line always contains a 
fixed number of fields separated by commas.
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Setting up the scanner
Prior to scanning, define certain scanner parameters which stay in the 
scanner’s non-volatile memory and remain active until you change them.

t To set-up the scanner parameters
1 From the ‘Scan’ menu in the ‘Scan’ window, choose ‘Scanner set-up’.
2 Set-up your scanner parameters as follows:

Selected scanner
Océ Scan detects the connected scanner. This option lets you select the active 
scanner, when there are several scanners installed on the same SCSI port 
(using different SCSI addresses).

‘Paper Load’ option

Camera alignment 
To perform camera alignment, please refer to your scanner’s installation 
manual.

‘Manual’ You insert the document and press ‘Paper feed’ on the 
scanner, to load it

‘Auto’ The scanner detects and loads the document, as soon as 
you insert it

‘Delay in deci-
seconds’

When you use auto load, set a time delay, to give yourself 
time to position the document correctly

‘Use fast load 
option’

The original is pulled only under the first roller axle and scan-
ning will start from there.
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Scanner media offsets
Correction Factor in scanning direction  This option allows you to tune the 
scanner's vertical precision setting. 

During scanning, an original image is digitized as it is propelled through the 
scanner. One at a time, thin strips of the image are processed as they pass the 
cameras.  Vertical precision is directly affected by the speed in which this 
happens. Inaccurate vertical precision results in vertical lines in the scanned 
image that are longer or shorter than the same lines in the original. 

You can modify the vertical precision from zero to a value between -1% and 
1%. Positive settings mean that the distance between scan lines will be 
increased, and negative settings mean that distance will be decreased. 

Media Offsets in ...  The Top(start), Bottom(end), Side offset edit fields define 
the scanning field offsets. You can use this option to correct slight offset 
irregularities.  

Note: Offset values are defined in inches or mm. depending on your 
Preferences - System - Unit settings. 

Offsets can be positive or negative:

n A positive offset value in the Side field means that the scanning field's side 
point is moved to the right and a negative value means it is moved to the left. 

n A positive value in the Top or Bottom fields means that the scanning field's 
top or bottom point is moved down while a negative value means that it is 
moved up. 

Accuracy Lens Enhancement (ALE)
Accuracy Lens Enhancement (ALE) is an electronic correction of spherical 
errors in CCD based camera- scanners.

When looking at pixels across the range of a camera, the pixels tend to be more 
elliptical at the outside edges of the lens and more round in the middle of the 
lens. This anomaly is known as a spherical lens error and can introduce 
inaccuracies in the scanning system that can vary quite substantially between 
different points along the scan line.
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ALE process electronically corrects the spherical errors in the scanner and 
maintain a stable maximum error across any two points of less than 0.1% ± 1 
pixel, which is part of our U.S. patent 5502578. Contex is the only scanner 
manufacturer to offer Accuracy Lens Enhancement (ALE) technology for their 
entire range of scanners. Contex is committed to developing only the highest 
levels of quality, accuracy and reliability.



26 Océ Scan User Manual

Making your first scan
Before you work with Océ Scan, check that you have switched on your scanner 
before you switch on the computer. This allows the computer to detect the 
scanner connection.

If you have turned on the scanner after the computer, click ‘Rescan bus’ to 
detect the connected scanner.

The Océ Scan windows
In Océ Scan, the default main window is the ‘Scan’ window.

To navigate between windows, click on the window’s corresponding tab at the 
bottom left of the screen.

[3] Océ Scan window tabs

The ‘Scan’ toolbar

[4] The ‘Scan’ toolbar

The scanning commands, from left to right, are:

n ‘Scan’: scans the document to file
n ‘Backward’: moves the document backward through the scanner
n ‘Halt’: pauses the prescan, to let you make adjustments
n ‘Forward’: starts the prescan
n ‘Stop’: aborts the scan
n ‘Eject’: advances the document forward through the scanner
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Scanning a document to file

t To scan a document to file (without adjustments)
1 Place your original document face down along the insertion slot on the scanner.
2 In Océ Scan, click the ‘Scan’ tab, to go to the scan window if necessary.
3 From the ‘Scan set-up’ tab, set ‘Scan preset’ to ‘none’.
4 From the drop-down list boxes, select the scanning mode, resolution, and 

paper size.
5 Click the ‘Scan’ button.
6 Specify the destination file name and directory.
7 Specify the output format (see ‘Selecting the output file format’ on page 27).
8 For certain formats, click ‘Options’ to give additional set-up parameters (see 

‘Setting up parameters for TIFF and JPEG’ on page 95).
9 Click ‘OK’, to start the scan. The file type extension displays next to the file 

name.

Selecting the output file format  

Select an output file format, before you scan a document to file.

Océ Scan supports more than 50 industry standard file formats for maximum 
compatibility with general and specialised applications within CAD, DTP, 
FAX, and Graphics.

Depending on whether you scan in colour or greyscale mode, specific output 
format types are available (see ‘Supported file formats’ on page 125).

When you choose an output format type, bear the following in mind:

n If you are scanning an image for use in a specialised computer application, 
consult your application’s parameter set-up requirements for imported image 
files.

n If you are scanning an image for archiving or post processing, the ‘TIFF’ 
format is a good choice because it is widely used and compatible with the 
majority of computer applications.

n In colour mode, the ‘JPEG’ format gives good compression, though with 
some loss of detail.
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Setting up scan parameters 
You indicate the following parameters prior to scanning:

n ‘Setting the original paper size’ on page 30
n ‘Setting the scanning resolution’ on page 33
n ‘Using scan presets’ on page 34

Setting the original paper size
Before you scan an original, indicate its size to the scanner by one of the 
following ways:

n Selecting a standard (US, ISO, and DIN) or custom paper size
n Entering a paper size in scanner units (page 30)
n Using automatic paper size detection (page 31)
n Entering a paper size by width only (page 31)

You can also:

n Create your custom paper sizes (page 32)
n Add an oversize factor to standard paper sizes (page 32)
n Define the paper size units (inches or millimetres) in ‘Preferences’ 

(‘Selecting preferences’ on page 19).

t To select a standard paper size
1 In the ‘Scan set-up’ tab, click the arrow next to the ‘Fixed paper size’ box. A 

submenu appears.
2 Select ‘Fixed paper size’. A list appears with standard and custom sizes and 

orientations.
3 Choose your original’s paper size and orientation.

t To set the paper size in scanner units
1 In the ‘Scan set-up’ tab, click the arrow next to the ‘Fixed paper size’ box. A 

submenu appears.
2 Select ‘Use Scanner Units’.
3 Enter a value in the box.

Note: On certain scanner models, you can measure the scanner units 
directly on the document insertion slot.
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The automatic paper detection feature detects paper sizes by comparing 
scanner background and image tones. Use automatic paper detection to set the 
scan width, or for originals that are near standard sizes.

Note:  This option is available on selected scanner models.

t To use automatic paper detection
1 In the ‘Scan set-up’ tab, click the arrow next to the ‘Fixed paper size’ box. A 

submenu appears.
2 Select ‘Auto paper size’.
3 Select from the list of available automatic paper sizing:

Note: The automatic paper sizing types available depend on your scanner 
model.

‘Auto size ISO/US’   detects the original’s width and left offset, approximating 
to the nearest standard ISO or US paper size. The orientation also affects 
automatic sizing. The length is based on the detected standard size.

‘Auto width’   detects the original’s width and left offset. Use this option, if 
your original does not correspond to any standard size.

‘Auto image width’   detects the original’s size, including the maximum paper 
width, and scans the entire length of the original.

t To enter the paper size by width
1 In the ‘Scan set-up’ tab, click the arrow next to the ‘Fixed paper size’ box. A 

submenu appears.
2 Select ‘Paper width only’.
3 Enter the paper width in the box.

t To customise a paper size
1 In the ‘Scan set-up’ tab, click the arrow next to the ‘Fixed paper size’ box. A 

submenu appears.
2 Select ‘Paper set-up’, then ‘Paper size’. A dialog box appears, with a list of 

available fixed sizes from which you can create, modify, or delete.

Note: The minimum scan width is a function of the scanner model you are 
using. Therefore, make sure that the customised paper size you want to 
define is not out of the range.
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t To create a custom fixed paper size

1 Click the ‘Add a new paper size’ button.
2 Enter the paper size name, width, height, and offsets.
3 Click ‘OK’.

t To modify a fixed paper size
1 Select the paper size you want to modify.
2 Modify its width, height, and offsets as applicable. 
3 Click ‘OK’.

Note: You cannot modify the width and height of standard paper sizes.
4 To change the position of the paper size on the list, click the up or down arrows.

t To delete a paper size
1 Select the paper size that you want to delete.

2 Click the ‘Delete’ button.

t To add an ‘oversize’ factor
1 In the ‘Scan set-up’ tab, click the arrow next to the ‘Fixed paper size’ box. A 

submenu appears.
2 Select ‘Fixed paper size’.
3 Select the paper size that is closest to, but smaller than your original.
4 From the submenu, select ‘Set-up’.
5 Select ‘Oversize’ (%).
6 Set the oversize factor (0, 1, 2, 3%...). This ‘oversized’ format appears in the 

list of available paper sizes as a standard size + oversize factor. (Example: 
A4P) 
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Setting the scanning resolution
Resolution, measured in dots per inch (dpi), indicates the fineness of detail in 
a scanned image. The higher the resolution you set, the finer the level of detail 
you will get in the output image.

Select the scanning resolution, before you scan or prescan a document. Choose 
a resolution based on the intended function of the final output image:

n For offset printing, set high resolutions.
n For on-screen display, set lower resolutions.
n High resolutions (300 dpi and above) are necessary, to display small details 

(as in maps) clearly. However, you will also have a larger file size. Consult 
your printer documentation for recommendations.

n Do not use an image editor to increase the image resolution, as this will not 
improve the image quality.

t  To set a resolution
1 In the ‘Scan set-up’ tab, click the arrow next to the ‘Resolution’ box. A 

submenu appears.
2 Select one of the following methods. The available methods depend on your 

scanner model.
‘Normal’   lets you set the scanning resolution in one dpi increments.

‘Turbo’   speeds the scanning process up to twice the normal speed. This option 
does not work for resolutions below 200 dpi.

‘Physical’  uses the actual unscaled physical resolutions of the attached 
scanner. This is useful if you scan in greytone mode for postprocessing.

‘Anti Aliasing’  A high quality resampling of the optical resolution. Scanning is 
performed at the scanner's physical resolution, and resampling to the requested 
resolution is done in the PC. Effective in cases where scanning of raster 
originals lead to moiré-like interferences in the scanned image (wavy patterns 
across the pictures). Note that it can take longer to transfer the high dpi data to 
the pc. The speed depends on the difference between the scanner's physical 
resolution and the user requested dpi.

‘High Quality’  The scanner increases camera exposure to add light and thus 
obtain higher quality. Works with both colour and B&W. Use this resolution 
setting with difficult originals that produce a high degree of noise in the scan 
result.
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Note: With the High Quality setting, the scanner scans at a slower speed 
and will readjust light profiles and black/white point after setting High 
Quality resolution and just before scanning. 

3 In the ‘Resolution’ box, select a resolution.

Using scan presets
A ‘scan preset’ is an option that stores the scan settings and adjustments that 
you use most frequently, such as:

n Resolution
n Scanning mode
n Black and white points selection
n Adaptive adjustments and threshold setting

Note: You cannot store paper size in a scan preset.

n You can use the available selection of scan presets. These presets have been 
tested with standard types of originals such as light paper, light/dark 
blueprint, light/dark brown sepia, grey transparency, and pencil. You cannot 
modify or delete the standard presets, but you can hide them from the 
selection.

n You can also create customised scan presets, which you can modify and 
delete, for your frequently used settings.

t To use a standard scan preset
1 In the ‘Scan set-up’ tab, from the ‘Scan preset’ list, select a preset 

corresponding to your type of original.
2 Click ‘Scan’, to apply the preset settings.

t  To hide the standard scan presets
1 In the ‘Scan set-up’ tab, click on the arrow next to the ‘Scan preset’ list. A 

submenu appears.
2 Select ‘Hide standard scan presets’. 

t To create a scan preset
1 Make a test prescan. Use the scan settings and adjustments most adapted for 

your type of original.
2 In the ‘Scan set-up’ tab, click on the arrow next to the ‘Scan preset’ list. A 

submenu appears.
3 Select ‘Create’.
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4 Give a name to your new scan preset (i. e. Roadmaps).
5 Click ‘OK’, to save and add it to the list of scan presets for future use with 

similar originals.

t To modify a scan preset
1 From the ‘Scan preset’ list, select a preset with settings that you want to 

change.
2 Make the necessary changes in the ‘Scan set-up’ and the ‘Adjustments’ tab.

Note: The name of the current scan preset automatically changes to 'None' 
to indicate a modification in the scan preset.

3 In the ‘Scan set-up’ tab, click on the arrow next to the ‘Scan preset’ list. A 
submenu appears.

4 Select ‘Create’.
5 Give a name to your modified scan preset.
6 Click ‘OK’, to save and add it to the list scan presets for future use with similar 

originals.

t To delete a scan preset
1 In the ‘Scan set-up’ tab, select a preset that you want to delete from the ‘Scan 

preset’ list.
2 Click on the arrow next to the ‘Scan preset’ list. A submenu appears.
3 Select ‘Delete’.
4 Confirm.
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Prescanning the original
When you make a prescan of an original document, you can adjust scan 
settings and perform simple image manipulations, such as image selection, 
alignment, and rotation.

Adjust the parameters during a prescan, to limit the quantity of data that will 
be lost, when you perform the very same manipulations in the image 
processing phase.

Making a prescan
During a prescan, the type of adjustments that you can make depends on the 
scanning mode that you choose. The ‘Adjustments’ tab displays the available 
settings for each selected mode.

t To start a prescan
1 Place your original document face down along the insertion slot on the scanner.
2 In Océ Scan, click the ‘Scan’ tab, to go to the scan window if necessary
3 From the ‘Scan set-up’ tab, set ‘Scan preset’ to ‘None’.
4 From the drop-down list boxes, select the scanning mode, resolution, and 

paper size.
5 Click the ‘Forward’, button. The document prescans.

n The panel on the left of the scan window displays an overview of the 
scanning document. 

n The panel on the right displays the details of the area indicated by a dotted 
rectangle in the overview panel.

n You can also drag this rectangle elsewhere in the overview panel to look at 
another of detail.

t To make adjustments
1 In the ‘Adjustments’ tab, modify settings as applicable. Wait one to two 

seconds between each modification, to let the scanner update the prescan.
Note: Although you may be working on a partial image in the detail panel, 
your adjustments apply to the whole image when you scan it to file.

2 Continue to modify settings, until you are satisfied with the prescan.
3 Click ‘Scan’, to scan to file.
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t  To select another mode for prescan
1 Click ‘Stop’. This aborts the prescan.
2 Return to the ‘Scan set-up’ tab, and select another mode.

Viewing image details during a prescan
During a prescan, you can view the details of different areas in a scanning 
image, in order to verify your adjustments and settings. The ‘Scan’ window 
contains two panels:

n The ‘overview’ panel on the left displays the entire view of the scanning 
image

n The ‘detail’ panel on the right focuses on a specific area of the scanning 
image (outlined by an indicator square in the overview panel)

t To focus on an area
n With the cursor, point and click on a specific area of the scanning image in 

the overview panel. A new prescan starts, displaying that area in the detail 
panel.

t To move the area indicator square
1 Click on the area indicator square in the overview panel. Drag the square to 

another area in the image.
2  Move the horizontal scroll bar in the detail panel, to change the horizontal 

position of the indicator square.
3  Click the ‘Forward’, ‘Halt’, and ‘Backward’ buttons on the toolbar, to change 

the vertical position of the indicator square.
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Manipulating the image during prescan
You can make the following image manipulations during prescan:

n ‘Selecting an area to scan’ on page 38
n ‘Scanning a mirror image of the original’ on page 38
n ‘Inverting colours during prescan’ on page 39
n ‘Aligning an image during prescan’ on page 40
n ‘Rotating the image during prescan’ on page 41

Selecting an area to scan
You can select a specific area within an image to scan.

t To scan a specific area in the image
1 In the ‘Scan set-up’ tab, select your settings such as scanning mode, resolution, 

and paper size.
2 Click ‘Forward’, to start a prescan. 

3 Click the selection button on the ‘Scan’ toolbar. The cursor changes to a cross 
hair.

4 Draw a rectangle, to cover the area you want in the overview panel.
5 You can resize or move the selection by dragging on its handles (corners and 

sides). This is possible in both the overview and detail panels.
6 Click ‘Scan’, once you have selected the area desired. 

Note: Area selection is a toggle function that you can turn off at any time. 
However, it must be on in order to scan the partial image to file.

Scanning a mirror image of the original
You can scan a mirrored image of your original.

Tip:   When you scan transparent negatives (from the back), you can use the 
mirror function and the inversion function simultaneously to create righted 
positives.
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t To scan a mirror image
1 In the ‘Scan set-up’ tab, select your settings such as scanning mode, resolution, 

and paper size.

2 Click the ‘Mirror’ button on the ‘Scan’ toolbar.
3 Click ‘Forward’, to start a prescan. You can see the mirrored effects of the 

image on screen.
4 In the ‘Adjustments’ tab, make the necessary settings.
5 Click ‘Scan’, when you are satisfied with the results.
6 Click ‘Stop’, if you want to cancel the operation and restart a prescan.

Note: Mirroring is a toggle function that you can turn off at any time. However, 
it must be on in order to mirror the image when you scan to file.

Inverting colours during prescan
n For black and white images, black inverts with white, to create a negative 

image, or a positive image from a negative original (black and white, 
threshold, or adaptive modes).

n For greyscale images, all shades between black and white are replaced by 
their opposite (greytone mode).

n For indexed and RGB images, red turns into cyan, green into magenta, and 
blue into yellow (indexed and RGB colour modes).

Tip:  When you scan transparent negatives (from the back), you can use the 
mirror function and the inversion function simultaneously to create righted 
positives.

t To invert colours
1 In the ‘Scan set-up’ tab, select your settings such as scanning mode, resolution, 

and paper size.

2 Click the ‘Invert’ button on the ‘Scan’ toolbar.
3 Click ‘Forward’, to start a prescan. You can see the inverted effects of the 

image on screen.
4 In the ‘Adjustments’ tab, make the necessary settings.
5 Click ‘Scan’, when you are satisfied with the results.
6 Click ‘Stop’, if you want to cancel the operation and restart a prescan.
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Note: Inversion is a toggle function that you can turn off at any time. 
However, it must be on in order to invert the image when you scan to file.

Aligning an image during prescan
When you do not insert a document horizontally into the scanner, the scanned 
image can be skewed. You can deskew the image electronically by rotating it 
along a horizontal axis.

Océ Scan can realign the image by selecting an alignment reference in the 
original image. 

t To set an automatic alignment

1 Click the ‘Align’ button.
2 Click ‘Forward’, to start a prescan. An alignment line appears on the screen. 

The alignment angle shows in the status bar at the bottom of the screen.
3 To exit the alignment function, click the ‘Align’ button (a toggle function).

You can manually modify the alignment reference line for best results by using 
your mouse as follows:

t To lengthen, shorten, or tilt the line
1 Move the cursor over the line’s ‘handles’ at the end points.
2 Drag the handles, to adjust the length or change the alignment angle.

To switch ends  Right-click the handle of one end point, to move the cursor 
over to the opposite end point.

To reposition the line  Move the cursor over the alignment, to reposition the 
line elsewhere, while retaining its original angle.

To cancel the alignment operations  

n Press the <ESC> key
n Click the ‘Stop’ button, to remove the line without aligning
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Rotating the image during prescan
The ‘rotation’ function allows you to rotate an image at a selected angle before 
you scan to file.

Note: Rotation effects are not displayed on screen during prescanning or 
scanning.

t To rotate an image during scanning:
1 In the ‘Scan set-up’ tab, select your settings such as scanning mode and 

resolution.
2 Select a paper size from the ‘Fixed paper size’ option (to activate the rotation 

functions).

Rotate left  

Rotate right  

Flip  

Rotate 180°  
3 Click one of the rotation buttons on the ‘Scan’ toolbar.
4 Click ‘Forward’, to start a prescan. You only see the rotation effects on the 

image in the ‘View’ window, after you scan it to file.
5 In the ‘Adjustments’ tab, make the necessary settings.
6 Click ‘Scan’ when you are satisfied with the results.

Rotation is a toggle function that you can turn off at any time. However, it must 
be on in order to invert the image when you scan to file.



42 Océ Scan User Manual

Scanning to file
t To scan a document to file (without adjustments)

1 Place your original document face down along the insertion slot on the scanner.
2 In Océ Scan, click the ‘Scan’ tab, to go to the scan window if necessary.
3 From the ‘Scan set-up’ tab, set ‘Scan preset’ to ‘none’.
4 From the drop-down list boxes, select the scanning mode, resolution, and 

paper size.
5 Click the ‘Scan’ button.
6 Specify the destination file name and directory.
7 Specify the output format (see ‘Selecting the output file format’ on page 42).
8 For certain formats, click ‘Options’ to give additional set-up parameters (see 

‘Setting up parameters for TIFF and JPEG’ on page 95).
9 Click ‘OK’, to start the scan. The file type extension displays next to the file 

name.

Selecting the output file format  

Select an output file format, before you scan a document to file.

Océ Scan supports more than 50 industry standard file formats for maximum 
compatibility with general and specialised applications within CAD, DTP, 
FAX, and Graphics.

Depending on whether you scan in colour or greyscale mode, specific output 
format types are available (see ‘Supported file formats’ on page 125).

When you choose an output format type, bear the following in mind:

n If you are scanning an image for use in a specialised computer application, 
consult your application’s parameter set-up requirements for imported image 
files.

n If you are scanning an image for archiving or post processing, the ‘TIFF’ 
format is a good choice because it is widely used and compatible with the 
majority of computer applications.

n In colour mode, the ‘JPEG’ format gives good compression, though with 
some loss of detail.
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Scanning in batches
You can scan similar types of documents that use the same mode and settings 
in a batch to save time.

Make your settings once, then use the same settings to scan an entire batch of 
documents.

t To scan in batches
1 Group similar types of documents in a batch.
2 Select one original that is representative of the batch.
3 From the ‘Scan set-up’ tab, choose the scan preset (if applicable), the mode, 

the resolution, and the paper size.
4 Click ‘Forward’, to make a prescan of this original.
5 From the ‘Adjustments’ tab, adjust the applicable settings until you are 

satisfied with the results.
6 From the ‘Scan’ menu, select ‘Batch scan’.
7 Click ‘Scan’. A dialog box appears with batch scan settings.
8 Select the batch scan settings. Click ‘OK’.
9 Insert the documents one by one into the scanner.

Tip: To speed up the loading process, select the ‘Autoload’ option (‘File’ 
menu/‘Preferences’/‘Scanning’).

The software gives automatic file names to documents scanned in a batch.

t To give automatic file names
1 In ‘Auto file naming’, select ‘By count’, and enter a number. The program uses 

that number to start naming your first document.
2 In ‘Scan to file’, select a destination folder and a representative file name (ex. 

map) for the scanned documents. The software generates an automatic file 
name. Each file name has 3 digits attached to it (ex. map004.tif, map005.tif, 
map006.tif, etc.).

3 Select ‘Overwrite existing files’, if you want the new files to overwrite the old 
ones. When you deselect this option, the file name counter increases until it 
finds a non-conflicting name.

4 Once the batch scan completes, rename your files as necessary.

 A batch scan log gives you the summary of each batch scan operation.
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t To create a batch scan log
1 In the ‘Batch scanning’ dialog box, select the ‘Log to file’ option.
2 Click the ‘Log Options’ button, to select the type of data logged, as follows:

‘Log for each batch’:  Image format, scan mode, resolution, scan adjustments

‘Log for each scan’:  File name, file size, paper size, hollerith code

n ‘Verbose’: This option presents the log data in a readable format for normal 
reference purposes

n ‘Compact, comma separated’: This option presents the log data in a format 
exportable to another application, such as a spreadsheet or database. Column 
headers appear only in a new or empty log file; otherwise the data appears 
without headers. The information fields that are irrelevant to the scan, remain 
empty. Each line always contains a fixed number of fields, separated by 
commas.

3 Select a destination folder for your log file.
4 Click ‘OK’.
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Scanning directly to a printer
You can scan a document, make the necessary adjustments, and then make an 
immediate print.

t To scan to a printer
1 Place your original document face down along the insertion slot on the scanner.
2 From the ‘Scan’ menu, select ‘Scan to print’.
3 From the ‘Scan set-up’ tab, select the scanning mode, resolution, and paper 

size.
4 From the ‘Adjustments’ tabs, make the necessary settings.
5 Click ‘Scan’. A ‘Print’ dialog box appears.
6 Select your printer options.
7 Click ‘OK’ to start printing.
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Scanning to the ‘View’ window
You can scan your document directly to the ‘View’ window. This allows you 
to make image adjustments and then save to a file.

t To scan to the 'View' window
1 Place your original document face down along the insertion slot on the scanner.
2 From the ‘Scan set-up’ tab, set ‘Scan preset’ to ‘None’.
3 From the drop-down list boxes, select the scanning mode, resolution, and 

paper size.
4 From the ‘Scan’ menu, select ‘Scan to viewer’.
5 Click the ‘Scan’ button. When the scan completes, the image loads and 

displays in the ‘View’ window.
Once in the ‘View’ window, you can make modifications to the image and save 
it.
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Scan to Net
This feature allows to scan from a single workstation and have the image saved 
to another computer connected to the same network. This is based upon a 
Client/Server solution:

n the SCANserver is the computer workstation connected with the scanner and 
hosting the scanning software.

n The SCANclients are the computers on the same network that can receive the 
scanned images.

Installation is made during the installation of Océ Scanner Agent. Please refer 
to the Scanner Maintenance Kit user manual for more details.

t To scan to Net
1 Place your original document face down along the insertion slot on the scanner.
2 From the ‘Scan’ menu, select ‘Scan to Net’.
3 Select a client from the list.

Note: The client may be password protected. Enter the clients password to 
gain access.

4 Press the Scan button.
5 In the Scan to Net dialog, enter a file name. The system will otherwise 

automatically create a file name based on the current date-time. Files cannot 
be overwritten on the client. If a file of the same name already exists on the 
client, the system will create a new name.

6 Select a format for your file. Formats can be adjusted through the Options 
button. 

7 Press OK to start the scan-to-net process.
8 If the client machine has been set up with scan-to-net authentication, you will 

be asked to enter the password for the client. Enter the password and select 
OK. 
A progress dialog will display the progress of the data transfer.
Note: Océ Scan will remember and default to the settings for each scan 
client.
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Scan to pdf
You can scan directly to the PDF file format. 

t Scan to PDF
1 In the file Save As dialog select an existing PDF file or create a new file name.
2 Select the PDF format as the file type in the Save As dialog. 
3 Click the dialog's Options button to display a dialog for setting quality, image 

smoothing and additional PDF format setup options.
4 Click OK to apply your settings and start scanning to a PDF  file. 
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Scanning thick media

About scanning Thick Media
Scanning needs are not always limited to convenient paper thin media. Many 
industries, such as reprographics and GIS, will find the need to digitize or copy 
images printed or pasted on thicker media such as cardboard, foamboards, 
gatorboards etc.

Thick media scanning is not as straight forward as normal scanning. Certain 
procedures should be followed in order to compensate for the original's 
bulkiness and stiffness. Thick media scanning also sets some limitations on 
certain scanning modes and automatic adjustments. This chapter is about the 
procedures and limitations involved when scanning thick originals.

The following guidelines and comments apply to media from 2 mm (0.08’) 
thick, hereafter termed ’thick media’ throughout this chapter. Original's from 
0 mm to 2mm are considered ’normal’ scanning media. The guidelines and 
instructions apply for scanner model's originally constructed for thick media 
scanning.

Adjusting the insertion slot.   Normally, the insertion slot on your scanner will 
be set to take in normal scanning media. To carry out thick media scanning, 
you must enlarge the insertion slot space on your scanner and fit it to your thick 
original. See the Operator's Guide that came with your scanner for instructions 
on making insertion slot adjustments.

Positioning the scanner.  Don't place the scanner pressed up close to a wall 
because a thick and stiff original will not bend and fall towards the floor as it 
passes out the other side of the scanner. Make sure you position your scanner 
so that the empty space behind it is at least as long as the original being 
scanned.

Inserting and supporting thick documents.  It is recommended to insert thick 
media using Center Alignment which gives a balanced grip from the rollers in 
the scanner. Remember to set the scanner to Center Alignment reading in the 
application's File Menu - Scan Preferences.
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It is also recommended you support the original with both hands during 
scanning so that it does not tilt and thus distort the image in the end result. This 
should be done both at front as the original enters the scanner and from behind 
as it exits.

Limitations to consider prior to scanning thick media
Prior to scanning thick documents, please consider the following precautions 
and limitations:

No prescanning  Prescanning is like scanning, but the scan is carried out only 
in memory. Prescanning is used when a user wishes to evaluate a scan while 
making such adjustments as color tones, threshold etc. In some modes, the 
scanner performs its own prescans in order to make automatic assessments and 
calculations.

Prescanning is carried out by repeated scans of the original as it automatically 
slides back and forth in a direct path over the cameras. Unfortunately, the sheer 
bulkiness and stiffness of thick media makes it likely to swerve slightly in its 
path over the cameras. This means that the mechanical ’sliding’ cannot be 
performed with enough accuracy to enable reliable prescanning.

Below is a list of the scanning tools and modes that require prescanning and 
therefore cannot be performed with thick media:

n Index Color scanning mode
n Histogram Auto in B/W threshold mode
n Histogram Manual in B/W threshold mode
n Apply buttons in the mode adjustment dialogs
n Black and White point Setup
n Automatic Alignment
n Scanwindow - Scan an isolated image portion

Speed is reduced.  In the thick media positions, scanning speed is 
automatically reduced in order to ensure smooth movement despite the media's 
low grade of flexibility. The ’Normal’ position gives the highest scanning 
speeds.

Edge distorsion  Scanning of thick originals can create distortions in the end 
result when the original's front edge meets the exit rollers or when the trailing 
edge leaves the entry rollers. To omit this problem, the leading and trailing 
edges are by default skipped when in one of the extended media thickness 
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positions, i.e., insertion slot positions other than ’Normal’. Skipping of the 
leading/trailing edges can be turned OFF/ON using the .'Extended thickness 
paper handling' capabilities.

This setting option will only be available on scanners originally constructed 
with thick media scanning capabilities. It is found in the 'Scanner Setup dialog' 
- 'Extended Thickness' - 'Use extended thickness paper handling check box'.

Scanner adjustments for thick media
Your scanner needs to keep certain internal factors in line in order to function 
properly. The scanner frequently performs a completely automatic adjustment 
of its light profile and stitching factor but only when in the ’Normal’ thickness 
position. When you raise the insertion area to accommodate thick media, these 
automatic adjustments are turned off and you have to take certain measures to 
maintain them.

Light profiles.  Adjustment of the light profiles must take place frequently 
because even slight movements of the cameras can affect optimal scanning 
conditions. As stated above, the light profiles are only adjusted at the ’Normal’ 
(0-2mm) position.

It is therefore important to let the scanner start up at the ’Normal’ position so 
that the light profiles will adjust themselves before your new scanning session.

If you are scanning thick media over many hours, then it is strongly 
recommended that you, from time to time, take down the insertion slot 
adjustment to the ’Normal’ position in order to trigger a new light profile 
adjustment. The scanning application will give a warning if a light profile 
adjustment hasn't taken place within the last two hours.

Stitching.  Stitching is the term used to describe the scanner's ability to connect 
image points between cameras, despite overlapping or missing pixels.

Stitching settings are also automatically adjusted in the ’Normal’ position but, 
unlike light profiles, the stitching settings found at the ’Normal’ position may 
not be correct for your thick media. Therefore, whenever you scan thick media 
at other positions than ’Normal’, you have to check the stitching factor and 
perhaps adjustment it.

Normally, only stiff media will affect stitching while flexible media will likely 
be stitched properly regardless of its thickness. Stiff media will ’perch’ itself 
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on top of the scanner rollers and thus rise a small distance over the glass plate 
which serves as the basis for ’Normal’ stitching settings.

The modified stitching parameters will automatically be selected when in one 
of the extended media positions and not in the ’Normal position’, where the 
standard automatic stitching setting is always used.

t Performing the stitching adjustments
1 Adjust the insertion slot to accommodate your thick media as described in the 

scanner's operations guide.
2 Load the thick original you wish to scan. Center loading is recommended with 

thick originals. The scanner's media transport rollers grip more evenly with 
center loading.

3 Select 'Scanner Setup' in the 'Scan' Menu.
4 Select the 'Extended Thickness' tab and check the option box to eneable 

making adjustments.
5 Make a test scanning. Bulky thick media needs to be supported with both 

hands on its way in and out of the scanner.
6 Stitching errors will be easiest to see on an image with one or more clear 

diagonal lines. If the lines seem uneven, check the box labeled Adjust for 
extended media thickness.

7 Change the value for each of the scanner's cameras. Normally, only positive 
values should be used.

8 Make test scans and readjust the values until you are satisfied that the lines are 
stitched correctly.

9 Click OK to accept your settings.
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Scanning modes

n ‘Black and white modes’ on page 54
n ‘Colour modes’ on page 59
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Black and white modes
Océ Scan offers the following black and white scanning modes. Certain modes 
are available only on selected scanner models and configurations.

Use the following guidelines, to select the scanning mode for your needs:

n ‘Black and white threshold mode’ on page 55
n ‘Black and white adaptive mode’ on page 56
n ‘Black and white Copy Normal’ on page 56
n ‘Black and white copy photo mode’ on page 57
n ‘Black and white Copy adaptive mode’ on page 57
n ‘Black and white photo mode’ on page 58
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Black and white threshold mode
This mode applies a global threshold value, to determine whether a pixel is 
black or white.

n Use for black and white drawings and line art.
n Adequate for drawings that do not have isolated difficult areas, for which a 

single global threshold value would suffice.

t To scan in B/W threshold
1 In the ‘Scan set-up’ tab, select a scan preset, if applicable.
2 From the ‘Mode’ drop-down list, select ‘B/W threshold’.
3 Select the resolution and paper size.
4 Click ‘Forward’, to prescan.
5 Select the threshold method (page 64):

n Manually (‘Threshold’ option) 
n Automatic histogram
n Manual histogram

6 Select also the following settings, if applicable.
n ‘Despeckling and hole filling’ (page 65)

7 Click ‘Scan’, when you are satisfied with the results.
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Black and white adaptive mode
A mode that adapts the threshold to darker or lighter areas in the original.
n Use for line drawings, particularly difficult blueprints and brown 

transparencies (sepias), or stained or faded originals.
n Produces relatively small file sizes suitable for digitising.

t To scan in B/W adaptive mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘B/W Adaptive’.
3 Select the resolution and paper size.
4 Click ‘Forward’, to prescan.
5 In the ‘Adjustments’ tab, make the following settings:

n ‘Adaptive adjustments’ (page 66)
n ‘Despeckling and hole filling’ (page 65)

6 Click ‘Scan’, when you are satisfied with the results.

Black and white Copy Normal
Dual 2D-Adaptive enhancement with ADL+ error diffusion halftoning and 
2D-Auto edge enhancement and 2D-Adaptive background suppression. This 
mode is suitable for copying (scan and print) of normal drawings with a 
reasonably good quality. Halftones are distributed throughout the image for 
softer transitions between black and white.

t To scan in B/W Copy Normal mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘B/W Copy Normal.
3 Select the resolution and paper size.
4 Click ‘Forward’, to prescan.
5 In the ‘Adjustments’ tab, make the following settings:

n ‘Adaptive adjustments’ (page 66)
n ‘Sharpen/soften’ filter (page 74)
n ‘Blur’ filter (page 69)

6 Click ‘Scan’, when you are satisfied with the results.
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Black and white copy photo mode
This halftoning mode uses Dual 2D-Adaptive enhancement with ADL+ (‘area 
diffusion logic’) error diffusion halftoning. This mode is suitable for copying 
(scan and print) of continuos shades of gray like in photos. Halftones are 
distributed throughout the image for softer transitions between black and 
white.

t To scan in B/W copy photo mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘B/W Copy Photo’.
3 Select the resolution and paper size.
4 Click ‘Forward’, to prescan.
5 In the ‘Adjustments’ tab, make the following settings:

n ‘Adaptive adjustments’ (page 66)
n ‘Sharpen/soften’ filter (page 74)
n ‘Blur’ filter (page 69)

6 Click ‘Scan’, when you are satisfied with the results.

Black and white Copy adaptive mode
This mode uses dual 2D-Adaptive enhancement with ADL+ error diffusion 
halftoning, 2D-Adaptive thresholding and 2D-Adaptive background 
suppression. This mode is suitable for copying (scan and print) of Sepia, 
Blueprint and other originals with heavily distorted foregrounds and 
backgrounds where the shades that create unwanted "noise" are close to the 
shades that make up the image's data and the two are hard to differentiate. 

t To scan in B/W Copy adaptive mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘B/W copy adaptive’.
3 Select the resolution and paper size.
4 Click ‘Forward’, to prescan.
5 In the ‘Adjustments’ tab, make the following settings:

n ‘Adaptive adjustments’ (page 66)
n ‘Sharpen/soften’ filter (page 74)
n ‘Blur’ filter (page 69)
n Background suppression( page 66)

6 Click ‘Scan’, when you are satisfied with the results.
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Black and white photo mode
This 8-bit halftoning mode uses dithering to convert greytones into black and 
white in the output image, according to the Floyd Steinberg algorithm.

n Use to scan photos and photo printouts

t To scan in B/W photo mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘B/W Photo’.
3 Select the resolution and paper size.
4 Click ‘Forward’, to prescan.
5 In the ‘Adjustments’ tab, make the following settings:

n ‘Brightness’ and ‘contrast’ (page 70)
n ‘Lightness’(page 71)
n ‘Gamma’ (page 67)
n ‘Sharpen/soften’ filter (page 74)
n ‘Blur’ filter (page 69)

6 Click ‘Scan’, when you are satisfied with the results.
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Colour modes
Océ Scan offers the following colour scanning modes:

n ‘Graytone mode’ on page 59
n ‘24-bit color (true colour) mode’ on page 60
n ‘Indexed colour mode’ on page 61
n ‘Classified colour mode’ on page 62

Graytone mode
n 8-bit mode
n Scans the actual grey tones of each pixel up to 256 levels
n Use for black and white photographs

t To scan in graytone mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘Graytone’.
3 Select the resolution and paper size.
4 Click ‘Forward’, to prescan.
5 In the ‘Adjustments’ tab, adjust the following settings:

n ‘Brightness’ and ‘contrast’ (page 70)
n ‘Lightness’(page 71)
n ‘Gamma’ (page 67)
n ‘Blur’ filter (page 69)
n ‘Black and white points’ (page 72)

6 Click ‘Scan’, when you are satisfied with the results.
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24-bit color (true colour) mode
n 24 bit true-colour mode
n Use for colour photographs and posters
n Produces large file sizes

t To scan in RGB mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘24-bit color’.
3 Select the resolution and paper size.
4 Click ‘Forward’, to prescan.
5 In the ‘Adjustments’ tab, make the following settings for best results:

n ‘Brightness’ and ‘contrast’ (page 70)
n ‘Lightness’(page 71)
n ‘Gamma’ (page 67)
n ‘Blur’ filter (page 69)
n ‘Sharpen/soften’ filter (page 74)

6 Click ‘Scan’, when you are satisfied with the results.
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Indexed colour mode
The indexed colour mode scans images with limited colours by mapping true 
colours to an indexed colour palette.

n Use for simple colour images that only require up to 256 output colours
n Produces small file sizes due to a limited number of output colours

t To scan in indexed colour mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘Indexed colour’.
3 Click on the adjacent ‘...’ button. A dialog box appears.
4 Select the number of output colours. 
5 Select one of the following methods, to calculate the index values:

‘Linear’   separates and limits the output colours of the image to the selected 
number, without a prescan. 
Example: If you choose 16 output colours from a true colour image, the entire 
colour spectrum (denoted by a wheel) will divide into 16 equal parts, to 
determine the output colours. This method can work for certain maps or line 
art images, but not for photographic images.

‘Adaptive photo’   uses an algorithm optimised for photographs, following a 
prescan analysis.

‘Adaptive map’  uses an algorithm optimised for maps, following a prescan 
analysis.

6 Select the resolution and paper size.
7 Click ‘Forward’, to prescan.
8 In the ‘Adjustments’ tab, make the following settings:

n ‘Brightness’ and ‘contrast’ (page 70)
n ‘Lightness’(page 71)
n ‘Gamma’ (page 67)

9 Click ‘Scan’, when you are satisfied with the results.
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Classified colour mode
The classified colour mode scans the observed colour features of an image, by 
using a colour look up table (LUT). 

n Requires the use of a ‘LUT’ file created from feature extraction
n Use for batch scans of similar types of documents that require similar output 

colours and enhancement.

t To scan in classified colour mode
1 In the ‘Scan set-up’ tab, select your scan preset.
2 From the ‘Mode’ drop-down list, select ‘Classified colour’.
3 Click on the adjacent ‘...’ button. A browser appears.
4 Select the ‘*.lut’ file that you want to use.
5 Select the resolution and paper size.
6 Click ‘Scan’. A dialog box appears.
7 Enter the file name and destination folder.
8 Click ‘OK’. Check that the output file size and colour filter results are 

satisfactory.
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Chapter 5 
Scanning adjustments

n ‘Setting the threshold’ on page 64
n ‘Despeckling and hole filling’ on page 65
n ‘Making adaptive adjustments’ on page 66
n ‘Editing the gamma curve’ on page 67
n ‘Blurring colours and greytones’ on page 69
n ‘Setting brightness and contrast’ on page 70
n ‘Setting the black and white points’ on page 72
n ‘Sharpening or softening edges’ on page 74



64 Océ Scan User Manual

Setting the threshold
The threshold is the value that determines at which level a pixel will convert 
to black or to white.

t To set manual threshold
1 In the ‘Adjustments’ tab, select ‘Threshold’.
2 Click the arrows in the adjacent box, to select a threshold value. A new prescan 

shows you the effect of the change.

t To set the automatic histogram
1 In the ‘Adjustments’ tab, select ‘Histogram auto’.
2 Click ‘Scan’ to scan the document to file without a preview.

Note: To preview the scan, click ‘Forward’, instead of ‘Scan’.
3 Select a file name and destination folder.
4 Click ‘Save’. The scanner makes an investigative scan. It computes the 

threshold value, based on the algorithmic analysis of the image’s greytone 
distribution. The histogram does not appear on the screen.

5  The document returns to the start position, and scanning proceeds using the 
computed threshold value.

t To set the manual histogram
1 In the ‘Adjustments tab’, select ‘Histogram manual’.
2 Click ‘Forward’, to prescan. The software computes an initial threshold value 

based on an algorithmic analysis of the histogram.
3 Click on different areas in the overview panel, to see the threshold effects on 

image details.
4 Click ‘OK’, if you accept the proposed value.
5 To change the value, click the threshold slider and drag it to a new value.
6 If you don’t want to modify the threshold value, click ‘Cancel’, to exit the 

‘Histogram’ dialog box.
7 Press ‘Stop’ and then ‘Forward’, to reset the histogram and change the 

threshold.
8 When you are satisfied with the results, click ‘OK’ to start scanning using the 

selected value.
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Despeckling and hole filling
When you scan in black and white, you have the option of cleaning small black 
spots from a white background, or filling small white holes in a black solid.

n ‘Despeckling’ removes black spots that are smaller or equal to the speckle 
size you define.

n ‘Hole filling’ fills with black a white speckle that is smaller or equal to the 
speckle size you define.

Despeckle/hole filling filters are only available in B/W threshold and B/W 
adaptive modes.

t To despeckle or fill holes
1 In the ‘Adjustments’ tab, select ‘Despeckle’ and/or ‘Hole filling’.
2 In the adjacent box, set the speckle size.
3 Click ‘Forward’, to prescan.
4 Click on different areas in the overview panel, to see the despeckling/hole 

filling effects on image details.
5 Change the speckle size, until you are satisfied with the results.
6 Click ‘Scan’, to scan the document to file. 
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Making adaptive adjustments
Adaptive (tonal) adjustments are available for the following scanning modes:

n  Black and white adaptive
n  Black and white copy normal
n  Black and white copy photo
n  Black and white copy adaptive
n  Black and white photo

 There are two adjustments to make: ‘adaptive level’ and ‘background 
suppression’ (on certain scanner models, only the adaptive level adjustment is 
available).

Setting the ‘adaptive level’
‘Adaptive level’ works like a threshold. The lower the value you set, the more 
background details show up in the scanned image. 

1 In the ‘Adjustments’ tab, set the value in the ‘Level’ box.
2 Click ‘Forward’, to prescan.
3 Adjust the adaptive level value for best results. After each change, a new 

prescan shows the effects in the image details.

Setting the ‘background suppression’
‘Background suppression’ subdues background detail when you raise the 
value.

n In the ‘Adjustments’ tab, set the value in the ‘Background suppression’ box.
Readjust the adaptive level value, if necessary.
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Editing the gamma curve
A gamma curve lets you adjust colour tones when you scan in the following 
modes:

n Black and white photo
n Greytone
n RGB, indexed, and classified colour

What is gamma?
Gamma measures the contrast that affects the midlevel greys of an image.

On a gamma curve, the lower left end typically represents the darker grey areas 
of the a scanned image, while the top right end represents the lighter grey areas 
of that image.

Adjust the gamma, to modify the brightness values of the middle range 
greytones without making drastic changes to the shadows and highlights of an 
image.

How to work with gamma curves 
You can set the gamma as separate curves for each colour (red, green, and 
blue), or as a common curve (global).

When you set the global gamma curve, Océ Scan copies the changes in the red, 
green, and blue curves. If you have set brightness and contrast previously, the 
curves reflect these settings.

n Edit individual curves, if you want to work on each colour channel separately
n Edit a global curve, if you want to maintain the colour balance (sufficient in 

most cases)

Note: In the greytone mode, you can only edit the global gamma curve.
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t To display the gamma curve
1 In the ‘Adjustments’ tab, select ‘Gamma curve’.
2 Click the adjacent ‘...’ button. The gamma dialog box appears.

t To edit the gamma curve
1 Select the ‘Red’, ‘Green’, or ‘Blue’ colour channel curve that you want to edit. 

The curves displayed represents the selected colours. 
2 Select ‘Identical curves’, to set all active curves to the same value.
3 Double click on the curve, to set and display the editing points (handles). You 

can click on these handles and drag them, to adjust the curves (either separately 
or as one curve).

4 Select either the ‘Linear’ or ‘Curve’ option, to select straight lines or curves 
between the handles.

5 In the ‘Gamma’ box, enter a value (a ratio of input vs. output).
6 Use the dialog box options and commands, to edit the gamma curves for best 

results.

Gamma dialog box options and commands
n ‘Undo all’: Resets the original gamma curves
n ‘Reset’: Resets the selected curve back to linear (1:1)
n ‘Line’: Displays the curve in a linear representation
n ‘S-curve’: Sets the Floyd-Steinberg curve, mostly used for photo 

enhancement
n ‘Grid’: Displays a grid in the background, to assist in the editing process
n ‘Apply’: Activates the gamma setting in a new prescan (the gamma dialog 

box stays open)
n ‘Cancel’: Restores the original gamma values (the gamma dialog box closes)
n ‘OK’: Accepts the gamma settings and exits the gamma dialog box. Océ 

Scan stores the modified curves, and downloads them to the scanner for the 
next scan or prescan.
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Blurring colours and greytones
Blur determines the smoothness of the transition from one colour to another. 
You can adjust the blur setting for an image during prescanning in the 
following modes:

t To set blur
1 In the ‘Adjustments’ tab, select ‘Blur’.
2 In the adjacent box, enter a value.
3 Click ‘Forward’, to prescan.
4 Adjust the blur value for best results. After each change, a new prescan shows 

the effects in the image details.
5 Click ‘Scan’, when you are satisfied with the results.
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Setting brightness and contrast
n Brightness indicates how light or how dark an image appears
n Contrast determines how much of the dark parts of the image stand out, and 

how much of the light parts of the image recede

During prescanning, you can adjust the brightness and contrast of an image in 
the following modes:

n Black and white photo
n Greytone and colour modes

t To set brightness and contrast
1 In the ‘Adjustments’ tab, click on the arrows of the ‘Brightness and contrast’ 

control button, to obtain the best appearance for the image. You can adjust this 
value between -100 to +100.
Note: Due to data buffering in the scanner, the adjustments require some time 
before the actually appear on screen.

2 Adjust the brightness and contrast for best results. After each change, a new 
prescan shows the effects in the image details.

3 Click ‘Scan’, when you are satisfied with the results.

 Tip:   You can save the brightness and contrast settings in ‘Scan presets’.
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Adjusting the lightness value
During prescanning, you can adjust the lightness setting for an image in the 
following modes:

n Black and white photo
n Greytone 

t To set the lightness
1 In the ‘Adjustments’ tab, click on the arrows of the ‘lightness’ control button 

to obtain the appearance desired for the image. You can adjust this parameter 
between -100 to +100.

2 Adjust the setting for best results. After each change, a new prescan shows the 
effects in the image details.

3 Click ‘Scan’, when you are satisfied with the results.

Set the lightness, saturation, and balance
During prescanning, you can adjust the lightness setting for an image in the 
indexed, classified, and RGB colour modes.

t To set lightness, saturation, and balance
1 In the ‘Adjustments’ tab, select ‘Lightness/Saturation/Balance’.
2 Click the adjacent ‘...’ button. A dialog box appears.
3 In the ‘Red’, ‘Green’, and ‘Blue’ boxes, enter the values.
4 Adjust the setting for best results, as follows:

n To test the setting, click ‘Apply’. The dialog box remains open. A new 
prescan shows the effects in the image details.

n To reset all values back to 0, click ‘Reset’.
n To use the original values, click ‘Cancel’. The dialog box closes.
n To apply the new values and close the dialog box, click ‘OK’.

5 Click ‘Scan’, when you are satisfied with the results.
Note: You can save these settings in 'Scan presets'.
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Setting the black and white points
Set the black and white points to determine the amount of highlight and 
shadow detail in a scanned image. This feature is available in greytone and 
colour scanning modes.

How does it work?
During a prescan, the selection of a black point and a white point in the 
scanning image allows you to determine: 

n a particular dark grey level to use as a reference for black in the output image 
n a particular light grey level to use as a reference for white in the output 

image.

The ideal is to calibrate the white point so that the lightest part of the image has 
zero detail, and to calibrate the black point so that the darkest part of the image 
has zero detail. The aim is to improve the overall image contrast.

t  To open the B/W point dialog box

1 Click the ‘B/W point’ button on the toolbar.
2 A prescan starts, and a dialog box appears with a luminance histogram of 

colours and greytones.
3 Select the following options, as applicable:

‘Logarithmic’  gives a different interpretation of the histogram. For example, 
when an image has a large white background, the histogram shows a very high 
peak, but hardly anything visible for other colours with fewer numbers of 
pixels. This option accounts for these differences by recalculating the 
histogram values, thus making single colours with large pixel numbers appear 
less dominating than in the histogram.

‘Keep colour balance’  This option retains the original colour balance of the 
red, green, and blue channels, as you modify the black and white points. For 
example, if an image appears too ‘blue’, you can deselect this option and adjust 
the blue channel separately without affecting the red and green channels. This 
option is active by default when the luminance histogram displays.
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‘Luminance’ or ‘RGB’  These options display a histogram based on either 
‘RGB’ or lightness values.

The initial histogram displays the original black and white points. You can set 
new black and white points automatically or manually.

t To pick the points automatically
1 Click ‘Auto’. The software calculates the darkest and lightest values in the 

image according to the current histogram (‘RGB’ or Luminance).
2 Click ‘OK’, to accept the values and exit the dialog box.

t To set a value for the points
1 In the ‘Red’, ‘Green’, and ‘Blue’ boxes, set the values for each point.

Note: If you have selected ‘Keep colour balance’, the ‘RGB’ values for each 
point will be the same.

2 Click ‘Reset’ if you want to return to the original values.

t To pick the points manually
1 Click on a black or white eyedropper, as applicable.
2 In the detail panel, pick a point. To go to a different detail area, drag the square 

in the overview panel.
3 Drag the cursor, to select an area of pixels. When you release the button, an 

average of the pixels in the area defines the black or white point.
4 To select one pixel, just click and release without dragging.

Note: Press the ‘ESC’ button, to deactivate the eyedropper at any time 
during the picking process and return to the B/W point dialog.

5 You have the following options:
n Click ‘OK’ to activate new settings.
n Click ‘Reset’ to return to the original values
n Click ‘Cancel’ to return to the original values and exit the dialog box

6 The new values shift in relation to the values established during calibration. To 
return to the calibration values, set the black point to ‘0,0,0’ and the white point 
to ‘255, 255, 255’.
n The range is 0, 0, 0 to 15, 15, 15 for the black point, and 128, 128, 128 to 255, 

255, 255 for the white point. These settings vary depending on the scanner 
model.

n These settings do not remain in the scanner’s memory. At start-up, the 
scanner applies the calibrated settings of 0-255 for the black and white 
points, respectively.



74 Océ Scan User Manual

Sharpening or softening edges
The ‘sharpen/soften’ filter intensifies or smoothes the edges in an image. 

Use this filter in conjunction with the ‘blur’ filter, to improve the overall 
quality of the scanned image by diminishing noise and enhancing image 
details.

This feature is available on selected scanner models and configurations.

t To sharpen or soften edges
1 In the ‘Adjustments’ tab, select ‘Sharpen/soften’.
2 In the adjacent box, enter a value to set the degree of sharpening or softening 

as follows: 
n Positive values sharpen edges
n Negative values soften edges

3 Click ‘Forward’, to prescan. 
4 Adjust the filter value for best results. After each change, a new prescan shows 

the effects in the image details.
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Histogram
A histogram is a bar graph that represents the statistical distribution of 
greytones in an image. Each column represents the number of pixels at a 
particular grey level.

In most cases, you see a histogram with two peaks:

n The first and higher peak represents the background information (the lightest 
grey tones) in the scanned original

n The second and shorter peak represents the line information (the darkest grey 
tones) in the scanned original

n Sometimes there is a third peak at a high greytone level. This occurs when 
the scanner’s camera has captured its own white reference background. You 
can prevent this by narrowing the scanwidth to the width of the original.

Normally, the histogram is based on a linear calculation, using the threshold 
value and number of pixels as parameters. 

To bring out more detail in the histogram, select the ‘Logarithmic display’ 
option. (For example, an image that contains a large white background will 
show a very high peak and other colours that are represented by relatively 
small amounts of pixels will hardly be visible.) 

A logarithmic function will recalculate the histogram. to make large groups of 
single colour pixels less dominating, and to bring out details that otherwise 
would not be visible in the histogram.

How to select a threshold value from the histogram
Normally, the best threshold selection lies in the deepest part of the valley, 
between the two peaks, and closest to the peak that represents background 
information in the drawing.

n When you scan at a specific threshold value, all grey tones below the 
threshold will be represented as black pixels. 

n All grey tones above that threshold value will be represented as white pixels.
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Chapter 6 
Processing image files

n ‘Working in the ‘View’ window’ on page 78
n ‘Modifying the image’ on page 81
n ‘Editing the image’ on page 84
n ‘Printing and converting image files’ on page 90
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Working in the ‘View’ window
n ‘Opening, saving, closing an image file’ on page 78
n ‘Getting the image file properties’ on page 79
n ‘Making a selection in the image’ on page 79
n ‘Zooming in the image’ on page 80

Opening, saving, closing an image file
n When you scan an image to file, it automatically loads and opens in the 

‘View’ window.
n You can also open previously scanned image files from your browser.

t To open a file
1 From the ‘File’ menu, select ‘Open’. A browser appears.
2 In the ‘Files of type’ box, select the file format you want.
3 Select the file.
4 Click ‘Open’.

t To save a file
n From the ‘File’ menu, select ‘Save’. The file is saved under the current file 

name.

t To save a file under a new name
1 From the ‘File’ menu, select ‘Save as’. A dialog box appears.
2 Enter a new file name.
3 Select the file format.
4 Click ‘OK’.

Note: You can also save a selected portion of the current image as a new file.

t To close an opened file
1 From the ‘File’ menu, select ‘Close’.
2 If you have made changes to the file, a dialog box opens, to give you the 

options for saving your changes.
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Getting the image file properties
You can display the following information for an image file:

n File name
n Size in bytes
n Image resolution
n Dimensions
n File format

t  To display the file properties
n From the ‘File’ menu, select ‘Properties’.

Making a selection in the image
You can make a selection in the image, to base your LUT filter or to create 
local viewboards.

t To define a selection in the image

1 Click the ‘Selection’ button to change the cursor into a cross hair.
2 Click and drag a rectangle, to cover a selected an area. You have the following 

possibilities:
n To resize, move the cursor over any rectangle corner, to display a resizing 

handle (a blue arrow). Click and drag any corner, to resize the rectangle.
n To change the location, move the cursor over any segment, to display the 

movement handles. Click and move the rectangle to another location on the 
image as needed. 

n To activate the ‘zoom’ function, click inside the rectangle.
n To abort moving and resizing operations, press the <ESC> key 

n To undo the selection and turn off the function, click the standard cursor.
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Zooming in the image
There are several ‘zoom’ functions that you can use in Océ Scan.

‘Zoom in’   allows you to select an area to view. You can select several zoom 
areas successively, until you turn off this mode by clicking the icon once again. 
You can get a zoom factor of up to 16:1.

‘Zoom out’   takes the view out to 2:1, with the pivot point positioned in the 
middle of the screen. This mode turns itself off.

‘Zoom bird’s eye’   displays a full view of the image with a frame outlining the 
current zoom area. You can click and drag the selected area to another location 
on the image.

‘Zoom grid’   is a toggle function that superimposes a one-pixel wide gray grid 
for visual separation of pixels, when the zoom factor is 8:1 or greater.



Processing image files 81

Modifying the image
n ‘Aligning the image’ on page 81
n ‘Cropping the image’ on page 82
n ‘Manipulating the image’ on page 83
n ‘Resizing the image’ on page 82

Aligning the image
You can align an image that has been skewed during scanning.

t To align an image

1 Click the ‘Measure’ button, to define an alignment reference line. The cursor 
becomes a marker.

2 On the image, click and drag a line, to use it as an alignment reference.
3 You can manually modify the alignment reference line for best results by using 

your cursor as follows:
n To adjust the length or change the alignment angle, drag the handles on the 

line’s end points.
n To switch endpoints, right-click the handle of one end point, to move the 

cursor over to the opposite end point.
n To reposition the line, click the handles, to move the line elsewhere while 

retaining its original angle.
n To zoom in further on the image, move the cursor away from the line. 

To cancel the line completely, click the ‘Measure’ button again.

4 When you have found the correct alignment, click the ‘Align’ button. The 
alignment angle appears in the status bar at the bottom of the screen.

5 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.
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Cropping the image
You can crop a selected portion of a scanned image and save it to file.

t  To crop a selection of the image

1 With the image open in the ‘View’ window, click the ‘Selection’ button, to 
select the area you want to keep.

2 Click the ‘Crop’ button. The program removes all image data outside the 
selection.

3 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.

Resizing the image
You can resize an image by applying a scaling factor.

t To resize an image
1 From the ‘Image’ menu, select ‘Scale’. A dialog box appears.
2 Click on the slider, to set a scaling factor.

Note: The default scaling factor is 100%.
3 Click ‘OK’, to resize the image.

From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.
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Manipulating the image
You can perform the following image manipulations from the ‘View’ toolbar:

t To manipulate the image
1 With the image open in the ‘View’ window, click one of the buttons below, to 

perform the manipulation you want:

Mirror  This function flips the image horizontally.

Measure  This toggle function allows you to measure the distance between two 
points by drawing a measure line between them. This line has handles on 
which you can pull to drag and resize. The measurements appear in the 
information field of the status bar.

Rotate right  This function rotates the image 90° to the right.

Rotate left  This function rotates the image 90° to the left.

Rotate 180°  This function rotates the image 180°.

Flip  This function rotates the image upside down.

Deactivate  Deactivates the current function and restores the standard cursor.

2 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.
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Editing the image
n ‘Counting the number of colours in an image’ on page 84
n ‘Getting the colour value of a pixel’ on page 84
n ‘Adjusting image brightness and contrast’ on page 85
n ‘Adjusting the image hue, saturation, and value (lightness)’ on page 85
n ‘Adjusting the image RGB values’ on page 86
n ‘Converting a colour image to greyscale’ on page 86
n ‘Converting an image to classified colour’ on page 87
n ‘Decreasing colours and greytones in an image’ on page 87
n ‘Despeckling a scanned image’ on page 88
n ‘Inverting the image colours’ on page 88
n ‘Stretching the histogram’ on page 89

Counting the number of colours in an image
This function displays the number of distinct colours that are present in the 
active image.

t To count colours
1 From the ‘Image’ menu, select ‘Count colours’.
2 A message box appears with the number of colours or greytones used in the 

image, viewboard, or selected partial view.
3 Click ‘Cancel’, to remove the message box.

Getting the colour value of a pixel
You can get the RGB or HSV value of a colour pixel or group of pixels in the 
image. The colour information displays in the status bar as follows:

n Intensity and RGB: I:‘#’ R:‘#’ G:‘#’ B:‘#’
n Intensity and HSV: I:‘#’ H:‘#’ S:‘#’ V:‘#’

t To get the pixel colour value

1 With the image open in the ‘View’ window, click the eyedropper button.
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2 Move the eyedropper over the pixel you want to display its value in the status 
bar.

3 To get the average value of a group of pixels, click and drag a square, to select 
the area of pixels. The computed average displays in the status bar.

4 To turn off the function, reclick the eyedropper button.

Adjusting image brightness and contrast
n Brightness indicates how light or how dark an image appears.
n Contrast determines how much of the dark parts of the image stand out, and 

how much of the light parts of the image recedes.

t To adjust brightness or contrast
1 From the ‘Image’ menu, select ‘Brightness/Contrast’. A dialog box appears:

n For greyscale images, this function applies to pixel values.
n For indexed colour images, this function applies to palette colours 

(individual RGB values).
n For RGB colour images, this function applies to pixel colours (individual 

RGB values).
2 Click and drag the slider, to set the brightness or contrast values between -100 

and 100.
3 Click ‘Preview’, to update the image without leaving the dialog box, or ‘OK’, 

to apply the settings and exit the dialog box.
Note: Press the <ctrl> key at the same time as you move the arrows, to 
display the effects on screen instantaneously.

4 Adjust the values for best results.
5 Click ‘OK’ to apply the correction, and exit the dialog box.

Note: If you click ‘Cancel’, the brightness and contrast settings return to 
their initial values.

6 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.

Adjusting the image hue, saturation, and value (lightness)
This technique allows you to correct the colour values of the image according 
to the HSV model.

n ‘Hue’: The colour changes depending on its location on the colour spectrum
n ‘Saturation’: The colours go from dull to brilliant
n ‘Value’ (lightness): The colours go from black to white
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t To adjust hue, saturation, and value
1 From the ‘Image’ menu, select ‘Hue/Saturation/Value’. A dialog box appears.
2 Click on the slider, to adjust the values.
3 Click ‘Preview’, to view the effects on the image without leaving the dialog 

box.
4 Click ‘OK’, to update the image and exit the dialog box.

Note: If you click ‘Cancel’, the HSV settings return to their initial values.
5 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.

Adjusting the image RGB values
You can also adjust the colour values of an image according to the RGB model.

t To adjust red, green, blue values
1 From the ‘Image’ menu, select ‘Red/Green/Blue’. A dialog box appears.
2 Click on the slider, to adjust the settings for each colour.

Tip: Press the <ctrl> key as you move the slider, to display the effects 
instantaneously on screen.

3 Click ‘Preview’, to see the effects on the image without leaving the dialog box.
4 Click ‘OK’, to update the image and exit the dialog box.

Note: If you click ‘Cancel’, the RGB settings return to their initial values.
5 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.

Converting a colour image to greyscale
You can convert feature extracted colours, indexed colours or RGB colour 
images to greyscale. Océ Scan replaces each colour with a grey tone of equal 
luminance (I=0.3R+0.59G+0.11B).

t To convert to greyscale
1 From the ‘Image’ menu, select ‘Greyscale’.
2 To undo the operation, deselect ‘Greyscale’.
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Converting an image to classified colour
You can apply the effects of a LUT filter to an existing RGB true colour image.

t To convert to classified colour
1 Open the image file in the ‘View’ window.
2 From the ‘Image’ menu, select ‘Classify’. A browser appears.
3 Select the ‘.lut’ file that you want to apply to your image.
4 Click ‘OK’, to convert to classified colour.

Decreasing colours and greytones in an image
This function is a fast, although unrefined way to reduce the image file size 
without going through the entire process of creating a feature extraction filter 
(LUT). This function works for black and white, greyscale, indexed, or RGB 
colour images

t To decrease colours and greytones
1 From the ‘Image’ menu, select ‘Decrease colours/greytones’.
2 Choose your settings as described below:

‘Black and white’  uses the lightness values of the input image as the basis for 
thresholding, either automatically or manually:

n ‘Auto threshold’ computes the threshold directly from the histogram.
n ‘Manual threshold’ lets you use the sliders, to set the threshold. Click 

‘Preview’, to adjust for best results.

‘Colours and greytones’   gives indexed colour output images that are based 
on an adaptive method or a custom palette:

n ‘Adaptive’ maps the image colours to the nearest colour for extracted, 
indexed, and RGB colours. For greyscale input images, the output greytones 
result from equalizing the histogram. Select either 16 fixed output colours, 
or the number of colours between 17 and 255. The output file type is 8-bit 
indexed, and the output file size will be the same, whether you choose 16 or 
255 colours.

n ‘Custom palette’ lets you load a .lut, .pal, .tif, .pcx palette. The number of 
output colours and image file type depend on the chosen.palette

3 Click ‘OK’, to decrease the colours and greytones.
4 From the ‘File’ menu, select ‘Save’ or ‘Save as’ to save the modification.
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Despeckling a scanned image
For scanned black and white images, you can clean small black spots from a 
white background, or fill small white holes in a black solid with the 
despeckling/hole filling function.

n ‘Despeckling’ removes black spots that are smaller than, or equal to the 
speckle size that you define.

n ‘Hole filling’ fills with black a white speckle that is smaller than, or equal to 

t To despeckle or fill holes

1 With the image open in the ‘View’ window, click the ‘Despeckle’ button.
2 Click the arrows, to set the speckle or hole size.
3 Click ‘OK’, to apply the settings and update the image.
4 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.

Inverting the image colours
You can invert the colours in a scanned image.

n For B/W images: black inverts with white and vice versa
n For greytone images: all shades between black and white are replaced by 

their opposite.
n For indexed and RGB colours: red turns into cyan, green into magenta, and 

blue into yellow.

t To invert colours in an image

1 With the image open in the ‘View’ window, click the ‘Invert’ button to invert 
colours.
Note: The inverted effect applies only on the image displayed on the screen, 
and not on the actual image file.

2 Reclick the ‘Invert’ button, to turn off the function.
3 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.
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Stretching the histogram
The histogram stretching function adjusts for optimal balance between 
highlights and shadows in your image.

This technique consists of removing the darkest and lightest pixels of an image 
and remapping the remaining ones over the whole lightness range (0-255). 
Globally, it results in an increase of the image contrast. As an example, you can 
use this method to clean up dirty white backgrounds.

t To stretch the histogram
1 From the ‘Image’ menu, select ‘Histogram stretch’. A lightness histogram 

appears.
2 Select ‘Manual’ or ‘Automatic’.

n ‘Automatic’ determines the optimal location for the black point (BP) and the 
white point (WP) on the histogram, then applies the corrections to the image.

n ‘Manual’ allows you to set the location of the black point (BP) and the white 
point (WP), by moving the arrows to any position within the lightness range 
(0 to 255).

3 Click ‘Preview’, to see the effect of the correction on the image on screen. The 
histogram dialog box remains open.
Tip:   Press the <ctrl> key as you move the arrows, to display the effects on 
screen instantaneously.

4 Adjust the values for best results.
5 Click ‘OK’, to apply the correction and exit the dialog box.
6 From the ‘File’ menu, select ‘Save’ or ‘Save as’, to save the modification.
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Printing and converting image files
n ‘Printing an image file’ on page 90
n ‘Printing image files in batches’ on page 91
n ‘Selecting a predefined printer profile’ on page 92
n ‘Creating a customised printer profile’ on page 94
n ‘Setting up parameters for TIFF and JPEG’ on page 95
n ‘Converting to another file format’ on page 96

Printing an image file
Using Océ Scan, you can print individual files or selections of image files.

t To make print settings
1 With the image open in the ‘View’ window, click the ‘Print’ button. A dialog 

box appears with the name of the default printer.
2 In the ‘Name’ box, select the printer (if different from the default printer).
3 Select your printing options as follows:

‘Print to file’  This option prints the image to a file. In the ‘Save as’ dialog box, 
enter a file name and destination folder.

‘Use Windows printer driver’  This option uses the Windows’ printer driver. 
Click ‘Properties’ to enter additional settings. (See Windows documentation 
for details).

‘Use direct printing’  This option uses a predefined printer profile or a 
user-defined profile.

4 In the ‘Printer profile’ box, select a profile.
5 Click the adjacent ‘Properties’ button, to enter a set-up dialog box.
6 From the ‘Printer specific’ tab, in the ‘Printer language’ box, select the format.
7 Click the adjacent ‘Properties’ button, to enter additional settings related to the 

format.
8 In the ‘Control’ box, select the control language.
9 Define the margins, if applicable.

10 Select the print resolution.
11 From the ‘Page set-up’ tab, select the paper size and orientation.
12 Click ‘OK’.
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t To make copy settings
1 In the ‘Print range’ box, you can choose:

n ‘All’, to print the entire image (default)
n ‘Selection’, to print a selected portion of the image that you have defined 

with the ‘Selection’ button
2 In the ‘Copies’ box, select the number of copies to print (between 1 and 999).
3 In the ‘Scaling’ box, select a scaling option:

n ‘Auto’ scales the image according to the selected page settings and printer 
profile

n ‘Manual’ lets you scale the image between 1 and 1000% (default)
4 Select ‘Offset’, if you want to cut off part of the image, in order to compensate 

for the top and left printer margins.
5 Click ‘OK’, to start printing.

Printing image files in batches
You can print multiple image files of the same format in a batch.

t To print in batches
1 From the ‘File’ menu, select ‘Batch Print’. A browser appears.
2 Select the files to print. Use the <shift> or <ctrl> key, to make multiple 

selections.
Note: Selected files must have the same format.

3 Select the ‘Suppress error messages’ option, to disable error messages during 
printing.

4 Click ‘Print’. The ‘Print’ dialog box appears.
5 Make your print and copy settings, as you would when you print individual 

files.
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Selecting a predefined printer profile
The properties for the predefined printer profiles are as follows:

n ‘CALS gp4 printer’ on page 92
n ‘CRF Printer’ on page 92
n ‘JDL Printer’ on page 92
n ‘LTX Printer’ on page 92
n ‘PCL Printer’ on page 93
n ‘RTL Printer’ on page 93
n ‘TIFF gp4 printer’ on page 93
n ‘Xerox (Xerox/Versatec) printer’ on page 93

CALS gp4 printer  

n Format: CALS gp4
n Control language: None
n Margins

CRF Printer  

n Format: CRF
n Resolution: Defaults to 400 dpi
n Control language: None or CDCL
n Margins

 JDL Printer   

n Format: JDL
n Model: 950 or 4000E. Defaults to 950
n Compression: Uncompressed, compressed, defaults to compressed.
n Resolution: 203 x 203 dpi or 203 x 406 dpi. Defaults to 203 x 203.
n Render type: Device Best, Cluster Dither, Pattern Dither, Scatter Dither, 

CMYK Contex RIP
n Control language: None
n Margins

 LTX Printer  

n Format: LTX
n Model: LTX320/321, LTX320L, LTX420, LTX420L. Defaults to LTX 320.
n Control language: None
n Margins
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 PCL Printer  

n Format: PCL
n Format options.
n Resolution: Defaults to 300 dpi
n Control language: None
n Margins

 RTL Printer   

n Format: RTL
n Compression: Uncompressed, Run length encoded, Pack bits, Seed-Row or 

Group 4.
n Resolution: Defaults to 300 dpi
n Render type: Device Best, Cluster Dither, Pattern Dither, Scatter Dither, 

CMYK Contex RIP
n Control language: None, HP, PJL
n Margins

 TIFF gp4 printer  

n Format: TIFF gp4
n Control language: None
n Margins

 Xerox (Xerox/Versatec) printer   

n Format: Xerox
n Format options
n Bytes/line: Defaults to 1320
n Resolution: 100, 200, 300 or 400 dpi. Defaults to 300 dpi
n Render type: Device Best, Cluster Dither, Pattern Dither, Scatter Dither, 

CMYK Contex RIP
n Control language: None, XEROX PJL
n Margins
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Creating a customised printer profile
You have the possibility of creating up to 10 customised profiles to meet your 
printing needs.

t To create a printer profile
1 With the image open in the ‘View’ window, click the ‘Print’ button. A dialog 

box appears with the name of the default printer.
2 In the ‘Name’ box, select the printer (if different from the default printer).
3 Under ‘Comment’, select ‘Use direct printing’.

t To create a printer profile
1 In the ‘Printer profile’ box, select the profile on which you want to base your 

new profile.
2 Click the adjacent ‘Properties’ button, to enter a set-up dialog box.
3 From the ‘Printer specific’ tab, in the ‘Printer language’ box, select the format.
4 Click the adjacent ‘Properties’ button, to enter additional settings related to the 

format.
5 In the ‘Control’ box, select the control language.
6 Define the margins, if applicable.
7 Select the print resolution.
8 From the ‘Page set-up’ tab, select the paper size and orientation.
9 Click ‘Clone’.

10 Enter a name for the new profile.
11 Click ‘OK’. The new profile figures in the list of available profiles.

t To delete a printer profile
1 In the ‘Printer profile’ box, select the profile that you want to delete.
2 Click the adjacent ‘Properties’ button, to enter a set-up dialog box.
3 Click ‘Delete’.
4 Click ‘OK’, to confirm the deletion, and to remove the profile from the list of 

available profiles.
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Setting up parameters for TIFF and JPEG
The two most widely used formats, TIFF and JPEG, have special set-up 
parameters that you define, when you save your scanned images under these 
file formats.

TIFF set-up  TIFF (Tag Information File Format) is a standard file format used 
by many raster and desktop publishing programs. It is also the standard image 
file format for many processing and enhancement applications.

t To define TIFF set-up parameters
1 From the ‘File’ menu, select ‘Save as’. A dialog box appears.

Note: You also get the same dialog box, before you scan a document to file

2 In the ‘File type’ box, select ‘TIFF’.
3 Click ‘Options’. A dialog box appears with the following compression types:

n ‘None’ (uncompressed): 8-bit grey level or 24-bit colour level versions 
n ‘Packbit’ (compressed): 8-bit grey level or 24-bit colour level versions
n ‘LZW’ (Lempel-Ziw-Welch) compressed grey level or colour versions

4 Choose the byte order (depending on the application in which you will be using 
your scan)
n ‘Intel’
n ‘Motorola’

5 Specify rows per strip or tile size (depending on the application in which you 
will be using your scan)
n ‘Rows per strip’
n ‘Tile width and length’

JPEG set-up  JPEG (Joint Photographic Experts Group) is a compression 
method for full-colour and greyscale images. It is a format best suited for 
scanned photographic images. It is not recommended to convert a black and 
white image to JPEG, because this will result in a poor quality greyscale image 
with a large file size.

JPEG is called a ‘lossy’ compression method, which means that after 
decompression, the output image may not be identical to the input image, due 
to loss of information. However, in typical photographic images, you can 
obtain very good compression levels without much visible change. You can 
also compress the file to a high degree, if you accept a lower quality image. 
The quality settings in the JPEG set-up allow you to make the compromise 
between image quality and file size.
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t To define the JPEG set-up parameters
1 From the ‘File’ menu, select ‘Save as’. A dialog box appears.

Note: You also get the same dialog box before you scan a document to file)
2 In the ‘File type’ box, select ‘JPEG’.
3 Click ‘Options’. A dialog box appears with the following compression types:

‘Quality’:   The higher the quality setting, the larger the JPEG file, and the 
closer the output image will be to the original input. Normally, you want to use 
the lowest quality setting (smallest file) that decompresses into something 
visually indistinguishable from the original image. This would be in the 50-95 
settings range. The default setting is 75, which gives an acceptable result. You 
can adjust the settings in increments of 5 and 10, until you get a good output 
image. However, settings above 95 are useless, since the compressed file size 
increases dramatically for hardly any gain in output image quality.

‘Smoothing’:   This option filters the input image, to eliminate fine-scale noise. 
A moderate smoothing factor of 10 to 50 may get rid of dithering patterns in 
the input file. This results in a smaller JPEG file, and a better looking image. 
A high smoothing factor will blur the image significantly.

Converting to another file format
You may have a whole list of files in the same format that need to be converted 
in exactly the same way. The application offers a convenient interface for 
multiple file (batch) conversions.

n Convert a single file
n Convert multiple files (batch convert)
n Save the conversion log

t To convert a file to another format
1 In the ‘View’ window, open the image file that you want to convert.
2 From the ‘File’ menu, select ‘Save as’. A dialog box appears.
3 Enter a file name (if different than the current name).
4 In the ‘Save as type’ box, select the new file format.
5 Click ‘Options’, to enter additional settings. Available options differ 

depending one the chosen file format.
6 Click ‘Save’, to convert and save the file.
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t To convert multiple files (batch convert)
1 From the ‘File’ menu, select ‘Batch convert’. A dialog box appears.
2 Select the files to convert. You can make multiple selections with the <shift> 

or <ctrl> keys.
Note: The input files must have the same file format.

3 In the ‘Save as type’ box, select the output file format. All files in the batch 
will convert to this same file format.

4 Click ‘Options’ to enter additional settings. Available options differ depending 
one the chosen file format.

5 In the ‘Directory’ box, select the destination folder for the converted files.
6 Click ‘Convert options’, if you want to invert, rotate, mirror, scale, or 

despeckle/hole fill the image files.
7 Select ‘Overwrite existing files’, if applicable.
8 Click ‘Convert’, to start the batch conversion.
9 If necessary, click ‘Abort’, to stop the conversion.

t To get a conversion log
1 A log displays the status of the conversion process and indicates problems with 

an error message.
2 When the conversion completes, a list of all successful conversions appear in 

the log.
3 Click ‘Save log’, if you want to keep a record of the conversion.
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n ‘Introduction to ‘Feature extraction’’ on page 100
n ‘Extract features with insert and import tools’ on page 102
n ‘Extract features with merge tools’ on page 104
n ‘Start feature extraction’ on page 106
n ‘Work in the LUT window’ on page 109
n ‘Edit the LUT’ on page 115
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Introduction to ‘Feature extraction’
‘Feature extraction’ is a process in which the user selects only the useful colour 
features in a scanned image and saves them in a filter for future scans of similar 
types of images.

What is colour feature extraction?
When you scan a colour map or drawing in true colour, the resulting image file 
contains many more colours than what the human eye can perceive (up to 16.7 
million). For example, the edge pixels of a red line on a white background can 
have gradations of reds, and a blue line crossing a red line will have pixels that 
are a mixture of red and blue.

The purpose of colour feature extraction is to filter all the colours in the input 
image so that only the perceived colours appear in the output image. As a 
result, you preserve and enhance the essential colour features in the image 
while reducing significantly the number of colours.

Why use colour feature extraction?
n To get smaller file sizes and faster scanning speed due to the limited number 

of colours
n  To achieve greater colour consistency and homogeneity in scanned files of 

similar types
n  To gain time in future scans or batch scans of similar originals (filter 

reusability)
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How you can create a filter used for colour feature extraction
You must create a special ‘LUT’ (colour ‘look up table’) filter for each type of 
original that you scan. You first scan a sample that is most representative of the 
original type, then edit its colours until the only output colours that remain are 
the colour features actually perceived by the human eye.

The LUT editor provides a set of tools to merge, explode, or remove colours. 
At the end of the editing process, you have a filter that ideally outputs only one 
colour for each feature in the scanned image.

How the scanner performs colour feature extraction
Using this ‘LUT’ filter, the scanner remaps the observed colours to the selected 
output colours.

Hence, the final image contains only the colours specified in the filter. The file 
data decreases from 24 bits per pixel to 4 or 8 bits per pixel.

Note: The ‘LUT’ filter effects apply to the entire image, and not to specific 
parts of the image.

When to use colour feature extraction?
n When you have enhance the clarity of faded or poor quality originals
n When you want to scan batches of similar originals
n When you want to reduce the file size of the scanned image without losing 

its essential features
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Extract features with insert and import 
tools

One of the techniques of feature extraction is to use the colour insert and 
import tools.

This technique is based on the few initial colours' method, which results in a 
greater number of LUT output colours than at the start. The insert and import 
tools add colours, to enhance the features in the image.

Below is an example of a CAD technical drawing, scanned in true colour RGB 
mode. The red lines represent one feature and the green lines represent another 
feature. Even with only two colours, the edge pixels are distorted with 
superfluous shades of green and blue.

[5] Generate a preliminary LUT with one colour

In this example, the preliminary LUT generates only one colour, as the 
specified number of output colours. This colour is based on its dominance in 
the image. In this case, you select a whitish colour that dominates the light 
background, and the red and green features in the image.
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The objective is to insert colours to which pixels will automatically remap. To 
do this, use the input colour pixels in order to create a LUT output colour.

[6] Insert a red and green into the LUT output colours

t To insert additional colours
1 Zoom in the image, to get a clear view of individual pixels (see ‘Zoom in the 

image’ on page 110).

2 Click the ‘Insert colour’ button (see ‘Insert a new colour’ on page 119).
3 Click and drag a rectangle, to cover an area with a variety of red pixels. The 

average value of these pixels become the newly inserted colour (also the new 
picked colour).

4 Click ‘Apply’, to remap the different red pixels to the new picked colour.
5 Repeat for the green feature. The final histogram shows three final output 

colours: white, red, and green.
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Extract features with merge tools
One of the techniques of feature extraction is to use the colour merge and 
removal tools.

This technique is based on the ‘excessive initial colours’ method, which results 
in a smaller number of LUT output colours than at the start. The merge and 
removal tools remap pixels to similar LUT output colours, to reduce the final 
number of LUT colours.

The example below of a map shows a dark line running through a greenish 
background. Feature extraction will reduce the number of colours in the 
background, to make the line clearer.

[7] Clean the background

To extract the line from the background, remap the edge pixels to either the 
background green or the dark line.
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t To clean the background

1 Pick a green pixel from the background (see ‘Pick a colour’ on page 116). 

2 Click the ‘Merge marked colour’ button, and mark the pixels in the 
background that you want to merge with the picked colour (see ‘Merge colours 
by manual selection’ on page 120).

3 Click ‘Apply’.
4 Toggle between the RGB/LUT views, to check the results (see ‘Switch 

between the RGB/LUT views’ on page 110).

[8] Sharpen the line

Once you have a clean background, you can merge the pixels in the line to a 
single dark brown colour.

t To sharpen the line

1 Pick a brown pixel from the line.

2 Click the ‘Merge marked colour’ button, and mark the pixels in the line that 
you want to merge with the picked colour.

3 Click ‘Apply’.
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Start feature extraction
n ‘Scan an image sample’ on page 106
n ‘Choose a LUT creation method’ on page 107
n ‘Base the LUT filter on a selection in the image’ on page 108

Scan an image sample 
To create a LUT filter for a class of documents, you begin by scanning a 
representative sample in true colour mode (RGB).

Follow these recommendations:

n Use the same resolution (dpi) that you will use later on, to scan documents 
in ‘classified’ mode. 

n Use the default settings for brightness and contrast, black and white points, 
etc. 

n Align your scan properly during scanning. Uneven lines create pixels with 
unnecessary colour shades that can complicate LUT editing.

n Do not modify your image in the ‘View’ window once scanning completes.
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Choose a LUT creation method
Depending on the type of original for which you want to create a filter, choose 
one of the following methods, to create a preliminary LUT from your true 
colour image:

t To select a LUT creation method
1 From the ‘Feature’ menu, select ‘Create LUT’. A LUT creation dialog box 

appears.
2 Select one of the following and click OK to create a preliminary LUT based on 

the chosen method.
‘Maps, CAD plots (adaptive)’  This option uses a specific algorithm adapted for 
vector type images.

‘Photo, artwork (adaptive)’  This option uses a specific algorithm adapted for 
raster type images.

‘Image independent (linear)’  This option redistributes evenly the actual input 
colours into the number of output colours that you specify.

‘Load predefined colours’  This option uses existing colour palettes that you 
select from the browser (of file type *.lut, *.tif, *.pcx, *.pal).

3 Click the adjacent ‘...’ button, to define the set-up parameters for the selected 
method:
‘RGB’ or ‘HSV’ are colour spaces that the algorithm uses, to calculate the 
colour distances.

'Number of colours':  sets the number of output colours that you want for the 
LUT filter.

‘Minimum distance’   designates the number of output colours, in function of 
the shortest distance between colours, as a percentage of the colour wheel 
(RGB or HSV).

4 In the ‘Number’ box, enter the number of colours.
5 Click ‘Browse’, to select the palette to use.
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Base the LUT filter on a selection in the image
You can base the preliminary LUT filter on a specific area of the scanned true 
colour image. That area should represent the essential features that you want 
to have in your final filter.

Select this area before you define the LUT filter settings.

Note: This option works only in the two adaptive modes (‘Photo, Artwork’ and 
‘Maps, CAD Plots’).

t To select an area
1 After your scanned true colour image opens or loads in the ‘View’ window, 

click the selection tool.
2 Click and drag a square, to cover the area you want.
3 Click the square’s handles, to edit or move the selection area as needed.

Note: You can only define one area.

4 From the ‘LUT’ menu, select ‘Create LUT’. A dialog box appears. The ‘Based 
on a selected rectangle’ option is selected.

5 Choose either ‘Photo, Artwork’ or ‘Maps, CAD Plots’.
6 Click the adjacent '...' button to define the settings for the preliminary LUT and 

click OK.
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Work in the LUT window
n ‘Choose the colour space method for LUT editing’ on page 109
n ‘Get pixel information’ on page 109
n ‘Switch between the RGB/LUT views’ on page 110
n ‘Zoom in the image’ on page 110
n ‘Use the viewboards to edit the LUT filter’ on page 111
n ‘View the output colours in the colour wheel’ on page 112
n ‘View the output colours in a histogram’ on page 113

Choose the colour space method for LUT editing
You can choose the type of colour space that the program uses in the LUT 
creation process. This determines the calculation method during the editing 
functions. Colours remap according to the chosen colour space.

Tip:   Select the colour space, before you start the LUT editing process, as any 
change affects only those colours remapped after the change.

t To choose the colour space
1 From the ‘Feature’ menu, select ‘Colour space’.
2 Choose either ‘RGB’ or ‘HSV’.

Get pixel information
During your LUT editing process, you can get information about an individual 
colour pixel by positioning your mouse over it. This information shows up in 
the status bar at the bottom right window, indicating:

n  The intensity and RGB or HSV values (I:‘#’ H:‘#’ S:‘#’ V:‘#’ or I:‘#’ R:‘#’ 
G:‘#’ B:‘#’)

n  The pixel count for that particular colour
n  The protection status for that particular colour

t To change the colour values from RGB to HSV
1 From the ‘File’ menu, select ‘Preferences’.
2 Select ‘Colour info field’, then ‘RGB’ or ‘HSV’.
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Switch between the RGB/LUT views
When you work in the LUT window, you can view the image as a true colour 
image or as a filtered colour image once you have applied the LUT. Switch 
between these two views, to see the effect of the modifications that you make 
in the LUT editing process.

This toggle function can work in conjunction with the zoom functions, either 
in the main view or in the viewboards.

t To switch between the RGB and LUT-applied views

1 Click the ‘RGB/LUT’ button on the toolbar.
2 Alternatively, you can right-click the image, to switch from the RGB and LUT 

views of the image.

Zoom in the image
There are several ‘zoom’ functions that you can use in Océ Scan.

‘Zoom in’   allows you to select an area to view. You can select several zoom 
areas successively, until you turn off this mode by clicking the icon once again. 
You can get a zoom factor of up to 16:1.

‘Zoom out’   takes the view out to 2:1, with the pivot point positioned in the 
middle of the screen. This mode turns itself off.

‘Zoom bird’s eye’   displays a full view of the image with a frame outlining the 
current zoom area. You can click and drag the selected area to another location 
on the image.
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‘Zoom grid’   is a toggle function that superimposes a one-pixel wide gray grid 
for visual separation of pixels, when the zoom factor is 8:1 or greater.

Use the viewboards to edit the LUT filter
There are two available ways of viewing an image: through the main view or 
the viewboards.

A new image always opens in the main viewboard. Local viewboards let you 
select three possible views of the same image. The image manipulation and 
LUT editing tools remain the same for any viewboard that you choose.

n The main viewboard displays the image on the screen at the present zoom 
level

n The local viewboards display selected parts of the image, which you can 
reposition or modify as needed. When you leave a viewboard, this partial 
view of the image remains stored.

t To define a local viewboard

1 In the main view of the image, click the ‘Selection’ button, to define an area 
that you want for a viewboard.

2 Click a local viewboard button (1, 2, 3) to save the selected area to that 
viewboard.

3 To return to the initial view of the image, click the main viewboard button on 
the toolbar.
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View the output colours in the colour wheel
The colour wheel shows the position of the LUT colours in the image that use 
the hue, saturation, value (lightness) or HSV colour space. This option is 
available only in the LUT editing mode.

t To access the colour wheel view

1 Click the colour wheel button on the LUT toolbar, to get the following 
representations of the output colours:
n ‘Hexagon’ on page 112
n ‘RGB cube’ on page 112
n ‘Inverted triangle’ on page 113

Hexagon  The hexagon on the right represents the hue and saturation of the 
LUT colours.

n The periphery of the hexagon gives all the possible hues in the colour 
spectrum.

n The position of the LUT colour discs denotes their level of saturation. The 
more it approaches the center of the hexagon, the less saturated the colour. 
Inversely, the more it approaches the edges of the hexagon, the more 
saturated the colour.

n The size of the LUT colour disc designates the proportionate number of 
pixels that are mapped to that colour in the original true colour image. Discs 
with small pixel counts have equal minimum sizes.

RGB cube  You can transform the hexagon into a three-dimensional RGB 
colour space.

t To view the RGB cube
1 Right-click the hexagon. A submenu appears.
2 Select ‘RGB cube’. You can rotate this cube in different directions, to view the 

colours from a variety of angles.



Start Feature extraction 113

t  To rotate the RGB cube
1 From the submenu, select ‘Rotate’. A control function appears. This function 

works like a joystick. Pull on the arrows, to control the cube’s rotation. You can 
also click on the cube’s corners and rotate it in the direction that you want.

2 You have the following options from the submenu:
n To return to the two dimensional view, select ‘HSV wheel’ (‘HSV Wheel’ is 

the default setting').
n To reset the RGB cube to its original position, select ‘Default position’.
n To view the pixel count as equally sized discs, select ‘Uniform size’.

Inverted triangle  The inverted triangle on the left represents the lightness 
(value) of the LUT colours.

n The top part of the inverted triangle represents the lightest colours, moving 
down to the bottom part which represents the darkest colours.

n You can focus on a limited number of colours by adjusting the area in which 
the colour discs are located in the triangle.

t To focus on a area of colours
1 Position your mouse on the horizontal line at the top of the inverted triangle.
2 Click and drag this line to the top of the area that you want to select.
3 Repeat for the horizontal line at the bottom of the inverted triangle. The 

selected area between the two lines is white. The colours within this selected 
area show up in the hexagon on the right side of the screen.

View the output colours in a histogram
The LUT histogram displays the LUT output colours that have been extracted 
from the original true colour image. The height of the columns indicate the 
proportional number of pixels that have been mapped to that particular colour. 
This screen is only active in the LUT creation mode.

t To access the LUT histogram

1 Click the histogram button on the LUT toolbar.
2 Choose the presentation of LUT histogram as a function of pixel count, or as 

output colour indexes, or as gradations of hue, saturation, and value 
(lightness).
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t To select a histogram presentation
1 From the ‘Feature’ menu, select ‘Histogram sorting’.
2 Choose one of the following sorting methods:

n ‘Pixel count’: sorts pixels by number in descending order, from left to right
n ‘RGB’: sorts RGB colour values in descending order.
n ‘HSV’: sorts HSV colour values in descending order.
n ‘Palette order’: sorts colours by their palette index values
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Edit the LUT
n ‘Make a selection in the image’ on page 115
n ‘Pick a colour’ on page 116
n ‘Explode a colour’ on page 117
n ‘Import new colours’ on page 118
n ‘Insert a new colour’ on page 119
n ‘Merge colours by manual selection’ on page 120
n ‘Merge similar colours’ on page 120
n ‘Protect a colour’ on page 121
n ‘Remove LUT output colours’ on page 122
n ‘Undo an operation’ on page 124

Make a selection in the image
You can make a selection in the image, to base your LUT filter or to create 
local viewboards.

t To define a selection in the image

1 Click the ‘Selection’ button to change the cursor into a cross hair.
2 Click and drag a rectangle, to cover a selected an area. You have the following 

possibilities:
n To resize, move the cursor over any rectangle corner, to display a resizing 

handle (a blue arrow). Click and drag any corner, to resize the rectangle.
n To change the location, move the cursor over any segment, to display the 

movement handles. Click and move the rectangle to another location on the 
image as needed. 

n To activate the ‘zoom’ function, click inside the rectangle.
n To abort moving and resizing operations, press the <ESC> key 

n To undo the selection and turn off the function, click the standard cursor.
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Pick a colour
You can pick a particular colour to edit in the image, whether you are in the 
main view, in the viewboards, in the colour wheel, or the histogram screen.

You can only select one colour to edit at a time. The picked colour shows up 
in the colour indicator box next to the eyedropper on the toolbar.

t To pick a colour pixel from the image
1 In the image, zoom in closely to the colour pixel that you want to pick.

2 Click the eyedropper on the LUT toolbar. The cursor changes to an eyedropper.
3 Click on the colour you that want to pick. This colour shows up in the indicator 

box next to the eyedropper. In the image, all the pixels containing that colour 
will flash, to show all the areas where that picked colour appears.

t To pick a colour from the histogram

1 From the LUT toolbar, click the histogram button. A bar graph appears as a 
function of the sorting method you have selected (by pixel count, palette order, 
or HSV).

2 Click the eyedropper on the LUT toolbar. The cursor changes to an eyedropper.
3 Click on the colour that you want to pick. A full-height black border appears 

around the column representing this colour. This colour also shows up in the 
indicator box next to the eyedropper.

t To pick a colour from the colour wheel

1 From the LUT toolbar, click the colour wheel button.
2 If necessary, narrow down the precise range of colours in the inverted triangle 

(indicating the lightness value). To do this, click and drag on the top and 
bottom horizontal borders. Only the colours that are located in this range, 
appear in the hexagon (indicating hue and saturation).

3 Click the eyedropper on the LUT toolbar. The cursor changes to an eyedropper.
4 Point and click on the colour disc that you want to select. In the inverted 

triangle, the picked colour disc is larger than the others. In the hexagon, the 
picked colour disc shows a line in the center. This colour also shows up in the 
indicator box next to the eyedropper.
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t  To deselect a picked colour
n Click once again on the eyedropper, to turn the function off. The last picked 

colour remains in the colour indicator box in the toolbar.

Explode a colour
The purpose of the LUT filter is to narrow down the number of output colours 
in a scanned image.

However, you can take a particular (unprotected) LUT output colour and 
explode it into several other colours. You can specify the number of new LUT 
output colours that you want to create.

t To explode a picked colour
1 Pick a colour to explode from the image, histogram, or colour wheel.

2 Click the ‘Explode colour’ button. A dialog box appears:
3 Click the slider (or type a value), to select the number of colours that you want 

to explode from your initial LUT output colour. You can select between 1 and 
63 colours.

4 Click ‘Apply’. The new LUT output colours are evenly redistributed in the 
range of the RGB colours that previously belonged to the initial LUT output 
colour. The remapping works according to the nearness method (colour 
distance) selected, when you defined your LUT setup parameters.
Note: The total number of active LUT output colours cannot become 
greater than 255 by using the ‘explode colour’ function.
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Import new colours
When editing a LUT filter, you can create, then add a colour, or import new 
colours from a palette file into your LUT output colours.

t To import a customised colour
1 From the ‘Feature’ menu, select ‘Import colour(s)’. A dialog box appears.
2 Move the slider, to define the RGB values of the new colour you want to add, 

either in the ‘RGB’ or ‘HSV’ colour spaces. The new colour appears on the 
left.

3 Click ‘Add to list’ for each new colour that you define.
4 Click ‘OK’. The new colour becomes part of the LUT output colours in the 

histogram and colour wheel.

t To edit the list of new colours
1 Mark the colour that you want to edit.
2 Click ‘Remove from list’ or ‘Replace’, to remove or replace an imported 

colour.

t To import a colour from a palette
1 From the ‘Feature’ menu, select ‘Import colour(s)’. A dialog box appears.
2 Click ‘From palette’, to display a browser.
3 Select a palette file to open (type.lut, .pcx, .tif, or .pal).
4 Click on the colours that you want to import. You can also make a multiple 

selection of colours by drawing a rectangle around an area of the palette with 
your mouse. This method selects all colours found within this area. The index 
values shown are valid for the last selected colour.
Note: You can deselect a colour to import by clicking again on the colour.

5 Click ‘OK’. The new colours now become part of the LUT output colours. The 
total number of colours cannot exceed 255.
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Insert a new colour
When you compress a true colour image into a LUT filtered output image, you 
naturally lose a great number of colours. However, you can insert new colours 
that are created, based on the existing colours in the original RGB image.

This function can improve the colour quality in the output image without 
greatly increasing the number of colours and the file size.

You can either insert the new LUT output colour from a single pixel, or from 
an average of colour pixels in the true colour image

t To insert a new colour
1 Go the main view of the image or one of the viewboards.

2 Click the ‘RGB/LUT’ button, to switch the image to true colour (RGB).
3 If necessary, zoom in on the colour pixel that you want to insert.

4 Click the ‘Insert new pick colour’ button.
5 To insert an average of colour pixels, click and drag the cursor, to draw a 

rectangle covering the area of pixels with the colour that you want. The 
average of the colour pixels in this area becomes the new picked colour, which 
shows up in the colour indicator box on the toolbar.

6 Alternatively, you can double-click on the individual colour pixel, to select it 
as the new LUT output colour. The pixels that belong to the new LUT output 
colour, flash on the image.

7 Click ‘Apply’. This operation remaps the nearest colours in the RGB image to 
the new LUT output colour. In the histogram and colour wheel, this new LUT 
output colour becomes the picked colour.

Note: Protected LUT colours do not remap to the new inserted colour.
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Merge colours by manual selection
You can pick a colour into which you merge other colours.

For example, you may have a white background that is spotted with gray or 
yellow. You can clean up that white, by merging the gray and yellow into the 
white. The result is a homogeneous white background.

t  To merge a colour
1 Pick a white colour into which you want to merge other colours.

2 From the toolbar, click the ‘Merge colour’ button.
3 With the mouse, click the gray and yellow that you want to merge with your 

white colour, to mark them for merging.
n In the histogram, a blue square at the foot of the gray and yellow columns 

indicates that you have marked these colours for merging.
n In the image, the marked white, gray, and yellow pixels flash, to show the 

areas that will merge into one colour.

4 Click the ‘Apply’ button. Now the original RGB input colours corresponding 
to the marked gray and yellow LUT output colours are re-mapped to the picked 
white LUT colour.
Note: If you want to un-mark a colour for merging, click once again on that 
colour.

Merge similar colours
You may have in your image different shades and tints of the same colour, such 
as several gradations of blue in a blue sky. You can merge these colours, to 
produce one single blue. When the difference in the colours is slight, this 
operation has the advantage of reducing the number of colours, and therefore 
the file size, without greatly compromising the colour quality in the output 
image.
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t  To merge a picked colour with similar colours
1 Pick out the blue colour that you want to merge.

2 Click the ‘Merge similar colours’ button. A dialog box appears.
3 Move the slider (or type a value), to specify the distance of similar blues (as a 

percentage of the full colour spectrum) that you want to merge with the picked 
blue colour. The colours pixels within this distance:
n flash on the image
n show a blue mark at the foot of the columns in the histogram
n show a straw in the centre of the discs in the colour wheel

4 Click ‘Apply’. This function merges all unprotected LUT output colours 
within the specified distance, into the picked blue colour.

Protect a colour
When you obtain a colour that you are satisfied with during the LUT editing 
process, you can protect that colour from accidental modification.

Once you have protected a colour, you cannot merge, remove, or explode it 
into other colours. However, you can merge other colours into it.

t  To protect a colour

1 On the LUT toolbar, click the ‘Protect colour’ button.
2 Click on the colour pixel that you want to protect.

n On the image, the pixels belonging to the protected colour flash.
n On the histogram, a red square at the foot of the column shows that the colour 

is protected.
n On the colour wheel, a red dot in the centre of the colour disc shows that the 

colour is protected.
3 When you have finished, click once again on the ‘Protect colour’ button to turn 

the function off. If you try to mark the protected colour for merging or removal, 
an error message displays.
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t  To un-protect a colour
1 On the LUT toolbar, click the ‘Protect colour’ button.
2 Point and click on the protected colour (marked by a red square in the 

histogram or red dot in the colour wheel) to remove the protection.
3 Click on the ‘Protect colour’ button once again, to turn the function off.

Remove LUT output colours
You can also remove a colour entirely from your LUT filtered image. The 
pixels corresponding to the removed LUT output colour remap to the nearest 
active LUT output colour.

n ‘To remove a colour by manual selection’ on page 122
n ‘To remove colours similar to a picked colour’ on page 123
n ‘To remove minor colours’ on page 123

t To remove a colour by manual selection
You can mark several colours for removal at a time.

1 On the LUT toolbar, click the ‘Remove colour’ button.
2 Click on the colours that you want to mark for removal (a blue dot appears as 

a marker).

3 Click ‘Apply’. The removed colours disappear from the colour wheel and 
histogram.
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t To remove colours similar to a picked colour
If you have several gradations of the same LUT output colour, it is possible for 
you to choose one and delete the rest. You specify the length of the radius from 
the picked colour to the other similar colours (as a percentage of the entire 
range of colours).

1 Pick a colour that you want to use as reference.

2 Protect that reference colour.

3 Click the ‘Remove similar colours’ button.
4 Click the slider to specify the radius from the picked colour to the similar 

colours. The pixels located within this radius:
n flash on the image
n show a blue mark at the foot of the columns in the histogram
n show a straw in the centre of the discs in the colour wheel

5 Click ‘Apply’. The removed colours disappear from the colour wheel and the 
histogram. The pixels corresponding to the removed LUT output colour remap 
to the nearest active LUT output colour.

t To remove minor colours
If you have a few LUT output colours with only a small number of 
corresponding pixels that do not greatly contribute to the colour quality of the 
filtered image, you can remove them from the active number of LUT output 
colours.

1 Click the ‘Remove minor colours’ button.
2 Click the slider (or type a value) to specify the minimum number of pixels 

corresponding to a LUT output colour to remove (as a percentage of the total 
number of pixels). The colours with a pixel count within this percentage:
n flash on the image
n show a blue mark at the foot of the columns in the histogram
n show a straw in the centre of the discs in the colour wheel
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3 Click ‘Apply’. This function remaps the pixels in the RGB image 
corresponding to the removed LUT output colours to the nearest active LUT 
output colours.

Undo an operation
You can undo a change that you don’t like. The ‘Undo’ function can also apply 
to the protection and removal of colours.

t To undo an operation

n On the LUT toolbar, click the ‘Undo’ button as many times as necessary, to 
undo the most recent unsaved changes.

Note: The ‘Undo’ function also reverses a colour’s protection status.
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n ‘Using available file formats’ on page 126
n ‘Setting the CALS Gp4 orientation’ on page 132
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Using available file formats
Océ Scan supports more than fifty industry standard file formats. The 
following reference section gives a brief description of the available formats 
in which you can scan your documents. However, consult your application’s 
user manual, to get detailed parameter requirements.

n ‘General image file formats’ on page 127
n ‘Fax file formats’ on page 128
n ‘Scanned trace subset files’ on page 128
n ‘Greyscale formats’ on page 129
n ‘Colour formats’ on page 130
n ‘Plot/print file formats’ on page 131
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General image file formats

Name Type/Application/Description

PCX Black and white format used by PC Paintbrush 
(Z-Soft Corporation)

ImgCM CADmate Raster to Vector conversion, EYES-TAR 
(Microtek scanners)

ImgCC AutoDesk CADcamera Raster to Vector conversion
ImgGEM GEMpaint and GEMscan (Digital Research, Inc.)
Rlc Softdesk CADOverlay and ViewBase
Rlc2 Similar to Rlc, but contains additional information at the end of the 

file
Ig4 Softdesk Group4 compressed format, similar to Rlc2, except that the 

raster data segments contain strips of Group 4 data.
Scn Eldak’s Raster to Vector conversion and raster editor
Rnl CAD overlay and Raster to Vector conversion

(GTX Corporation), using simple run-length encoding
Gtx-G3 CAD overlay and Raster to Vector conversion 

(GTX Corporation), using CCITT G3 encoding
Gtx-G4 CAD overlay and Raster to Vector conversion

(GTX Corporation) using CCITT G4 encoding
Ras Sun raster format (a native bitmap format for UNIX)
Eps Encapsulated postcript format, compatible with desktop publishing 

applications
Bmp Microsoft Windows native bitmap format
Cut Media Cybernetics Dr. HALO raster editor
Hrf CADCore format (Hitachi Inc.)
CALS Gp4. 
Type1

CALS untiled format, compatible with CCITT 
Group4 format

CALS 
Gp4.Type2

CALS tiled format, compatible with CCITT Group4 format

CALS 
Gp4.Type4

CALS tiled format, compatible with CCITT Group4 format

JEDMICS Black/white tiled raster data format as defined by the 'Joint Engineer-
ing Data Management Information and Control System'. The image 
is divided into tiles of 512 * 512 pixels, each tile being compressed 
with the 2-dimensional CCITT group 4 encoding algorithm.

Rst Raster format (Indigo Graphics Systems Inc.)
Gr4AB ABB Engineering Automation Inc. format compatible with CCITT 

Group4
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Fax file formats
When you scan or convert to a fax file format, Océ Scan generates multiple 
output files, each corresponding to a normal fax file (letter or A4 size). The 
files have numbered extensions .001, .002, to .00n. You can send these files to 
normal Group 3 fax machines from a work station via a fax board.

Scanned trace subset files
Océ Scan works only with the trace entity subset of the DXF/DXB formats. 
Therefore, once you have modified a scanned DxfTR/DxbTR file in the CAD 
system, Océ Scan can no longer convert it or print it.

VifAB ABB Engineering Automation Inc. format, compatible with run-
length compressed format (intergraph type 24)

CitIN INTERGRAPH Inc.format, compatible with CCITT Group4
RleIN INTERGRAPH Inc. format, compatible with runlength compressed 

format
Pict Format for Macintosh (packbit encoding)
Pro-Rlc Xerox Pro Scan Rlc format
Wpf Wicks & Wilson internal file format
Tif Tag information file format for Aldus/Microsoft, compatible with a 

number of raster and desktop publishing. It is also the standard image 
file format for image processing and enhancement programs.

Name Type/Application/Description

Fax Gamma fax board format (version 3.3c)
Fax2 Enhanced format for newer Gamma fax boards
PcxMU A generic fax file format. The scanned file is stored in multiple files 

in Pcx format

Name Type/Application/Description

DxfTR A trace subset of the general Drawing Exchange file format. This 
format is simple to export to other computer systems because it is 
written in an ASCII file

DxbTR A trace subset of the general Drawing Exchange Binary file format, 
which stores the file as binary data. This compresses the file about 
ten times more than the Dxf format
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When you scan or convert to the trace subset formats, define the following 
parameters, which control the raster-to-CAD entity transformation that takes 
place on the fly, during scanning and conversion:

Error  A range of 0 to 15 is the maximum value allowed, when generating the 
CAD trace entities. A small value, such as 0 or 1, gives the finest resolution 
and detail. However, it has the inconvenience of the largest file size, which 
slows the scanning and converting speed. A value of 0 gives a file size 
approximately 3 times larger than a value of 1. A median value of 4 gives a 
reasonable resolution for most purposes, while higher values tend to roughen 
the edges and make the text unreadable.

Speckle  A range of 0 to 15 sets the sides in pixels of a square filter, to remove 
smudges during scanning or converting. You should normally set this value 
equal to, or less than, the error value. Larger values can remove significant 
details from the image.

Layer   A range of 0 to 99 sets the layer number in the CAD system to which 
the DxfTR or DxbTR file will import.

Unit  ‘I’ or ‘M’ sets the scale of the scanned or converted file to either inches 
or millimetres. This setting should correspond to the units used in your CAD 
system.

Greyscale formats
The grey tones are maintained, when you convert files between the various 
greyscale formats.

When you convert a greyscale format to a line mode format, specify a 
threshold value between 0 and 255 in the ‘Special’ option in the ‘Scan’ 
window, or from the ‘File’ menu in the ‘View’ window (‘Preferences’, ‘File’).

Greyscale formats produce large size files. For example, an E-size image 
scanned at 300 dpi results in a 150 Mb file.

Name Type/Application/Description

Tif Tif uncompressed 8-bit grey level version
Tif Tif packbit compressed 8-bit grey level version
Tif Tif LZW (Lempel-Ziw-Welch) compressed grey level, widely 

compatible
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Colour formats
The colour formats are available, when you scan in the RGB, indexed, or 
classified colour modes. The colours are maintained, when you convert 
between the following colour formats.

24-bit true colour formats produce large files. For example, an E-size image 
that is scanned at 300 dpi, results in a 450 Mb file.

Igs Softdesk uncompressed greyscale format
Pcx Greyscale 8-bit format, widely compatible

(Z-Soft for PC Paintbrush)
Ras Native greyscale format for UNIX
Jpeg/Jpeg 2000 Joint Photographic Experts Group compressed format

Name Type/Application/Description

Tif Tif uncompressed 24-bit colour level version
Tif Tif packbit compressed 24-bit colour level version
Tif Tif LZW (Lempel-Ziw-Welch) compressed colour version
Tif Feature extracted and indexed 8-bit and 4-bit colour formats
Bmp Microsoft Windows bitmap file format, in 24-bit true colour and 8-bit 

and 4-bit feature extracted and indexed colour formats.
Pcx 24-bit true colour, 8-bit and 4-bit feature extracted and indexed colour 

formats (Z-Soft for PC Paintbrush)
Ras Native 24-bit true colour, 8-bit and 4-bit feature extracted and indexed 

colour formats for UNIX
Jpeg Joint Photographic Experts Group compressed format
Rtl Hewlett Packard Raster Transfer Language 8-colour output file format 

(3 bitplanes) supported on the HP-DesignJet and the NovaJet plotters.
Pcl Hewlett Packard 24-bit output file format
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Plot/print file formats

Name Type/Application/Description

Pcl Format for Hewlett-Packard LaserJet-compatible laser printers
Plt File format for electrostatic, thermal and ink-jet plotters using an 

HPGL controller.
Note: When you connecting to an HPGL plotter, check that the hard-
ware flow-control over the parallel or serial port is implemented ac-
cording to the manufacturer specifications. This ensures that the 
computer does not transmit data faster than the plotter can process.

Ver CADMate electrostatic large-format plotter raster output file format. 
The VersaTec data format is also available (VersaTec Inc.)

Ltx Roland Inc.LTX420L, LTX420, LTX320L, and LTX320/321 ther-
mal large format plotter raster output file format

Crf CalComp Inc. DrawingMaster thermal large format plotter raster 
output file format

Jdl Japan Digital Laboratory Inc. Express Plotter output file format
Atl Atlantek Inc. 24-inch thermal plotter raster output file format
Con Contex Hybrid thermal plotter raster output file format
Scm SCANmate electrostatic large-format plotter raster output file format 

(System Partner Gmbh)
Rtl Hewlett Packard Raster Transfer Language supported on the 

HP7600, HP-DesignJet, Océ Graphics thermal plotters, and NovaJet 
plotters

Gra GraphTek thermal plotter raster output file format
Generic 
Cals

CALS type 1 format, widely supported by most plotters
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Setting the CALS Gp4 orientation
For CALS Gp4 files, the way in which the optical acquisition deals with 
orientation requires two operations.

The pixel-path (sometimes referred to as pel-path) and line-progression 
directions specified for the document will guide the user when he processes the 
image.

To get proper viewing, a user application will take the pixels from the data 
stream, and place them on the screen in the directions indicated. It will lay 
down the first line of pixels along the pixel-path direction, then the second one, 
etc. along the line-progression direction.

The user application knows its own requirements. if the target device is a 
display, the pixels may be placed in memory In one organization. if the target 
device is a printer, the pixels may be placed in memory by the application In a 
different way.

The pixel-path direction may have any of four values and the line-progression 
direction can be at either of the two possible right angles to it. Therefore, this 
model can describe images that are not only rotated, but also mirrored either 
vertically and/or horizontally. This allows the orientation parameters to 
describe how to image a file that might have resulted from scanning the back 
side of an aperture card or paper sepia. The figures below illustrate the possible 
orientations.

[9] CALS orientation

If a mix of scans is done in such a way that the images are not properly 
oriented, a visual post-process is necessary. When the operator views each 
scan, he identifies which direction would be ‘up’ for proper viewing 
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orientation, and corrects the orientation parameters. No other change or actual 
rotation is required.

When the end user requires that all files have the same orientation, that is the 
pixel-path direction is set to 0 and line-progression direction is set to 270, an 
additional step of actual rotation is necessary. This condition Is generally 
specified in configurations where the viewing subsystem is not powerful 
enough to perform at display time any needed rotation, due to previous 
random-orientation scanning.
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How to read this manual
The consistent style that is used in this manual enables you to quickly become 
familiar with the use of this manual and ultimately the Océ Scan.

Description  Each section or subsection contains a description of the feature or 
operation identified in the title. It might also include possible applications, as 
well as any guidelines that you should bear in mind.

Procedures  A description is followed by a procedure. A procedure always 
begins with a phrase which briefly describes the procedure, followed by a 
series of numbered steps that take you, step by step, through all phases of 
performing the operation. 

Figures and tables  Figures and tables are titled and numbered sequentially 
throughout this manual. Figures include pictures of product components, 
screen dumps, examples, and diagrams of concepts discussed in the 
description.

Attention getters  There are several types of information to which we draw 
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters which ensure the proper 
functioning of the machine or application, but useful advice concerning its 
operation may also be given.

Attention: The information that follows ‘Attention’ is given to avoid 
damage to your copy or original, the copier or printer, data files, etc.

Caution: The information that follows ‘Caution’ is given to prevent you 
suffering personal injury. .
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User survey
Did you find this manual to be accurate? 
o Yes 
o No

Were you able to operate the product after reading this manual? 
o Yes 
o No

Does this manual provide adequate background information? 
o Yes 
o No

Is the format of this manual convenient in size, easy to read and layed out well? 
o Yes 
o No

Did you find the information you were looking for? 
o Always 
o Most of the times 
o Sometimes 
o Not at all

How did you find the information you were looking for? 
o Table of contents 
o Index 
o Neither

Are you satisfied with this manual? 
o Yes 
o No

Thank you for evaluating this manual.  
If you have any other comments or concerns, please explain them on the 
following page.
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Comments: 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
 
--------------------------------------------------------------------------------------------- 
Date:

This reader’s comment sheet is completed by: 

Name (optional):

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V. 
Attn: ITC-User Documentation 
P.O. Box 101 
5900 MA Venlo 
The Netherlands

Send you comments by E-mail to: itc-userdoc@oce.nl

For the addresses of local Océ organizations see: www.oce.com
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Addresses of local Océ organizations

Océ-Australia Ltd.
P.O.Box 363
Ferntree Gully MDC VIC 3165
Australia

Océ-Österreich GmbH
Postfach 95
1233 Vienna
Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordetlaan 32
1140 Brussels 
Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187
01060-970 Sao Paulo, SP
Brazil

Océ-Canada Inc.
4711 Yonge Street, Suite 1100
Toronto, Ontario M2N 6K8
Canada

Océ Office Equipment (Beijing) Co Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China

Océ-Èeská republika s.r.o.
Hanusova 18
14021 Praha 4
Pankrác,
Czech Republic

Océ-Danmark A.S.
Kornmarksvej 6
DK 2605 Brøndby
Denmark

Océ-France S.A.
32, Avenue du Pavé Neuf,
93161 Noisy-le-grand, Cedex
France

Océ-Deutschland GmbH
Postfach 101454
4330 Mülheim an der Ruhr (13)
Deutschland

Océ (Hong Kong China) Ltd.
12/F 1202 The Lee Gardens
33 Hysan Avenue, Causeway Bay
Hong Kong

Océ-Hungária Kft.
P.O.B. 237
1241 Budapest
Hungary

Océ-Italia S.p.A.
Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia

Océ Systems (Malaysia Sdn. Bhd.)
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Malaysia
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Océ-Nederland B.V.
P.O.Box 800
5201 AV ‘s-Hertogenbosch
The Netherlands

Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo 4
Norway

Océ-Poland Ltd.
ul. £opuszañska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.
Av. José Gomes Ferreira, 11
Ed. Atlas II Miraflores
1495 Algés
Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
#03-00 Wisma Gulab
190 MacPherson Road
Singapore 348548

Océ España SA
Business Park MAS BLAU
C/Osona 2, 2-3a Planta
08820 El Prat del Llobregat (Barcelona)
Spain

Océ-Svenska AB
P.O.box 1231
S-164 28 Kista
Sweden

Océ-Schweiz AG
Sägereistrasse 29
CH8152 Glattbrugg
Switzerland

Océ (Taiwan) Ltd.
No. 99-24 Nan Kang Road Sec.2
Taipeh, Taiwan
Taiwan, RO

Océ (Thailand) Ltd.
16th Floor, B.B. Building
54 Asoke Road, Sukhumvit 21
Bangkok 10110
Thailand

Océ-U.K.Ltd.
Langston Road
Loughton, Essex IG10 3SL
United Kingdom

Océ-USA Inc.
5450 North Cumberland Av.
Chicago, Ill. 60656
U.S.A.
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Index

A
Adaptive level   66
Adjustments

adaptive level   66
background suppression   66
black and white points   72
blur   69
brightness and contrast   70
despeckle/hole fill   65
gamma curve   67
lightness value   71
sharpen or soften filter   74
threshold   64

Align image (in View)   81
Align image (prescan)   40
Alignment detection   21
Area selection

edit   79
Auto paper size   31

B
Background suppression   66
Batch print   91
Batch scan   43

log   44
preferences   22

Black and white modes
Adaptive   56
Adaptive photo   54
Copy ADL+   56
Grey adaptive mode   57
Photo   58
Photo ADL+   58
Threshold   55

Black and white points   72
Blur   69
Brightness and contrast   70
Brightness and contrast (in View)   85

C
CALS Gp4 orientation   132
Camera stitching   26
Classified colour conversion   87
Colour modes   59

Classified   62
Greytone   59
Indexed   60
RGB (true colour)   62

Colour wheel   112
Convert file formats   96
Convert image

to classified colour   87
to greyscale   86

Correction factor   23
Count colours   84
Crop image (in View)   82

D
Decrease colours and greytones   87
Default scan file   20
Despeckle/hole fill (prescan)   65
Detail panel   37
Display window   19

F
Feature (LUT) window   15
Feature extraction

adaptive method   107
based on image selection   108
image sample   106
introduction   100

File
format (output)   27
open, save, close   78
properties   79
supported formats   125

First scan   26
Flip image (in View)   83
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G
Gamma curve   67
Grey adaptive mode   57
Greyscale conversion   86

H
Histogram   75

LUT output colours   113
stretch   89

Histogram prescan resolution   20
Hole fill/despeckle (prescan)   65
Hue, saturation, and value   85

I
Image alignment (prescan)   40
Invert colours (prescan)   39
Invert image colours   88

L
Lightness value   71
Lightness, saturation, and balance   71
LUT creation method   107
LUT editing

colour space   109
explode colour   117
import customised colour   118
insert new colour   119
merge similar colours   121
pick a colour   116
pixel information   109
protect colour   121
remove colour   122

M
Measure image (in View)   83
Media offsets   24
Mirror image (in View)   83
Mirror image (scan)   38

O
Océ Scan

windows   14
Oversize factor   32
Overview panel   36

P
Paper position   20
Paper size

Auto paper size   30
by width only   31
custom   32
detection   21
original   30
oversize factor   32
scanner units   30

Pixel information   109
Pixel value   84
Preferences   19

batch scanning   22
prescanning   20
scanning   19

Prescan
adjustments   63
an original   36
mode   20
preferences   20
resolutions   20

Presets (scan)   34
Print image files   90

in batches   91
Printer profiles   92

CALS gp4 printer   92
CRF Printer   92
customised   94
JDL Printer   92
LTX Printer   92
PCL Printer   93
RTL Printer   93
TIFF gp4 printer   93
Xerox (Xerox/Versatec) printer   93
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R
Resize image (in View)   82
Resolution setting   33
RGB cube   112
RGB values adjustments   86
RGB/LUT-applied views   110
Rotate image (in View)   83
Rotate image (prescan)   41

S
Scan

in batches   43
presets   34
to file   42
to Net   47
to print   45
to viewer   46
toolbar   26

Scan window   15
Scanner

selected   23
setup   23
units   30

Scanning preferences   19
Sharpen and soften filter   74

T
Threshold   64
TIFF and JPEG setup   95
Toolbar (scan)   26

V
Vertical precision   23
View image details (prescan)   37
View window   15
Viewboards   111

W
Windows in Océ Scan   26

Z
Zoom functions   80
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